
Használati útmutató

TERÁPIAIRÁNYÍTÓ SZOFTVER DIABÉTESZ KEZELÉSÉHEZ



6025179-205_a

REF MMT-7335

©2011 Medtronic MiniMed, Inc. Minden jog fenntartva.

A Paradigm® Veo™ a Medtronic MiniMed, Inc. védjegye.

A Paradigm®, a Paradigm Link®, a Guardian REAL-Time®, a CareLink® és a Bolus Wizard® a Medtronic MiniMed, Inc. bejegyzett védjegye.

A BD Logic® a Becton, Dickinson and Company bejegyzett védjegye.

A CONTOUR®, a GLUCOFACTS®, az ASCENSIA™, a GLUCOMETER™, a DEX™, az ELITE™ és a BREEZE® a Bayer védjegye.

A LifeScan®, a OneTouch® UltraLink™, a OneTouch® Profile®, a OneTouch® Ultra®, a OneTouch® UltraSmart®, a OneTouch® Basic®, a OneTouch® FastTake®, a OneTouch® SureStep®, a
OneTouch® UltraMini®, a OneTouch® Ultra® 2, valamint a OneTouch® UltraEasy® a LifeScan, Inc. védjegye.

Az Optium Xceed™, a Precision Xceed™, a Precision Xtra®, a Therasense FreeStyle®, a FreeStyle® Flash, a FreeStyle Mini® és a FreeStyle Papillon™ mini az Abbott Laboratories, Inc.
védjegye.

Az ACCU-CHEK® Active, az ACCU-CHEK® Aviva, az ACCU-CHEK® Compact és az ACCU-CHEK® Compact Plus a Roche Group egy tagjának a bejegyzett védjegye.

A Java™ a Sun Microsystems, Inc. védjegye.

A Microsoft® és a Windows® a Microsoft Corporation bejegyzett védjegye.

Az Adobe® és az Acrobat® Reader® az Adobe Systems, Incorporated bejegyzett védjegye.



Kapcsolatfelvétel:
Africa:
Medtronic Africa (Pty) Ltd.
Tel: +27 (0) 11 677 4800

Australia:
Medtronic Australasia Pty. Ltd.
Tel: 1800 668 670 (product orders)
Tel: 1800 777 808 (customer help)

Azerbaijan:
Albatros Health Care
Tel: +994 12 498 9537

Bangladesh
Sonargaon Healthcare Pvt Ltd.
Mobile: (+91)-9903995417
or (+880)-1714217131

Belarus:
Badgin Ltd
Tel: +375 (172) 665128

België/Belgique:
N.V. Medtronic Belgium S.A.
Tel: 0800-90805

Bosnia and Herzegovina
Intermedical
Tel: +387 33 202 183
Fax: +387 33 202 183

Brasil:
Medtronic Comercial Ltda.
Tel: +(11) 3707-3707

Bulgaria
Interagro-90 Ltd
Tel: +359 888 636 033

Canada:
Medtronic of Canada Ltd.
Tel: 1-800-284-4416 (toll free/sans-frais)

China:
Medtronic (Shanghai) Ltd.
24 Hour Help (Cell): +86 400-820-1981
24 Hour Help (Landline): +86 800-820-1981

Croatia
Oktal Pharma
Tel: +385 1 659 57 77
Fax: +385 1 659 57 01

Croatia
Medtronic B.V.
Tel: +385 1 488 11 20
Fax: +385 1 484 40 60

Danmark:
Medtronic Danmark A/S
Tel: +45 32 48 18 00

Deutschland:
Medtronic GmbH
Geschäftsbereich Diabetes
Telefon: +49 2159 8149-370
Telefax: +49 2159 8149-110
24-Stdn-Hotline: 0800 6464633

Eire:
Accu-Science LTD.
Tel: +353 45 433000

España:
Medtronic Ibérica S.A.
Tel: +34 91 625 05 42
Fax: +34 91 625 03 90
24 horas: +34 901 120 335

Europe:
Medtronic Europe S.A. Europe, Middle East and Africa
Headquarters
Tel: +41 (0) 21-802-7000

France:
Medtronic France S.A.S.
Tel: +33 (0) 1 55 38 17 00

Hellas:
Medtronic Hellas S.A.
Tel: +30 210677-9099

Hong Kong:
Medtronic International Ltd.
Tel: +852 2919-1300
To order supplies: +852 2919-1322
24-hour helpline: +852 2919-6441

India:
India Medtronic Pvt. Ltd
Tel: (+91)-80-22112245 / 32972359
Mobile: (+91)-9611633007

Indonesia:
Medtronic International Ltd.
Tel: +65 6436 5090
or +65 6436 5000

Israel:
Agentek
Tel: +972 3649 3111

Italia:
Medtronic Italia S.p.A.
Tel: +39 02 24137 261
Fax: +39 02 24138 210
Servizio assistenza tecnica: Nº verde
24h: 800 712 712

Japan:
Medtronic Japan Co. Ltd.
Tel: +81-3-6430-2019

Kazakhstan:
Medtronic Kazakhstan B.V.
Tel: +77273110580

Latin America:
Medtronic, Inc.
Tel: 1(305) 500-9328
Fax: 1(786) 709-4244

Latvija:
Ravemma Ltd.
Tel: +371 7273780

Macedonia:
Kemofarm
Tel: +389 2 260 36 03
Fax: +389 2 260 36 49

Magyarország:
Medtronic Hungária Kft.
Tel: +36 1 889 0688

Malaysia:
Medtronic International Ltd.
Tel: +603 7946 9000

Middle East and North Africa:
Regional Office
Tel: +961-1-370 670

Montenegro:
Glosarij
Tel: +382 20 642 495
Fax: +382 20 642 540



Nederland, Luxembourg:
Medtronic B.V.
Tel: +31 (0) 45-566-8291
Gratis: 0800-3422338

New Zealand:
Medica Pacifica
Phone: 64 9 414 0318
Free Phone: 0800 106 100

Norge:
Medtronic Norge A/S
Tel: +47 67 10 32 00
Fax: +47 67 10 32 10

POCCИЯ:
Medtronic B. V.
Tel: +7 495 580 73 77
24h: 8-800-200-76-36

Philippines:
Medtronic International Ltd.
Tel: +65 6436 5090
or +65 6436 5000

Polska:
Medtronic Poland Sp. Z.o.o.
Tel: +48 22 465 6934

Portugal:
Medtronic Portugal Lda
Tel: +351 21 7245100
Fax: +351 21 7245199

Puerto Rico:
Medtronic Puerto Rico
Tel: 787-753-5270

Republic of Korea:
Medtronic Korea, Co., Ltd.
Tel: +82.2.3404.3600

Romania:
Trustmed SRL
Tel: +40 (0) 21 220 6477

Schweiz:
Medtronic (Schweiz) AG
Tel: +41 (0)31 868 0160
24-Stunden-Hotline: 0800 633333
Fax Allgemein: +41 (0)318680199

Serbia
Epsilon
Tel: +381 11 311 5554
Fax: +381 11 311 5554

Singapore:
Medtronic International Ltd.
Tel: +65 6436 5090
or +65 6436 5000

Slovenija:
Zaloker & Zaloker d.o.o.
Tel: +386 1 542 51 11
Fax: +386 1 542 43 32

Slovenská republika:
Medtronic Slovakia o.z.
Tel: +421 26820 6986
Fax: +421 268 206 999

Sri Lanka
Swiss Biogenics Ltd.
Mobile: (+91)-9003077499
or (+94)-777256760

Suomi:
Medtronic Finland Oy
Tel: +358 20 7281 200
Help line: +358 400 100 313

Sverige:
Medtronic AB
Tel: +46 8 568 585 10
Fax: +46 8 568 585 11

Taiwan:
Medtronic-Taiwan Ltd.
Tel: +886.2.2183.6068
Toll Free: +886.0800.005.285

Thailand:
Medtronic (Thailand) Ltd.
Tel: +662 232 7400

Turkiye:
Medtronic Medikal Teknoloji
Ticaret Ltd. Sirketi.
Tel: +90 216 4694330

USA:
Medtronic Diabetes Global Headquarters
Tel: +1-800-826-2099
24 Hour HelpLine: +1-818-576-5555
To order supplies: +1-800-843-6687

Ukraine:
Med EK Service Ltd.
Tel: +380445457705

United Kingdom:
Medtronic Ltd.
Tel: +44 1923-205167

Österreich:
Medtronic Österreich GmbH
Tel: +43 (0) 1 240 44-0
24 – Stunden – Hotline: 0820 820 190

Česká republika:
Medtronic Czechia s.r.o.
Tel: +420 233 059 401
Non-stop help line:
+420 233 059 059



Tartalom

1. fejezet 1 Bevezetés
1 Jellemzők
2 Biztonság
2 Kapcsolódó dokumentumok
2 Támogatás
2 Támogatott készülékek
5 Megrendelés
5 Az útmutató használata
6 A felhasználó biztonsága

2. fejezet 7 Első lépések
7 Mielőtt hozzákezdene...
7 Elsődleges rendszerfeladatok
8 Navigálás a rendszerben
8 A CareLink Pro megnyitása
8 Munkaterületek
9 Eszköztár
9 Betegrekordlapok
9 Az útmutató
10 Az útmutató be- és kikapcsolása
10 A betegek rekordjainak megnyitása
11 A betegek rekordjainak bezárása
11 Rendszerbeállítások megadása
12 Általános beállítások
13 A betegprofilok beállításai
14 Az adatmezők kiválasztása
14 Egyéni mező hozzáadása
14 Az adatmezők sorrendjének megváltoztatása
14 A betegprofil beállításainak véglegesítése
14 A betegkeresés beállításai
15 A megjeleníteni kívánt adatok kiválasztása
15 Az oszlopok sorrendjének megváltoztatása
15 A betegkeresés beállításainak véglegesítése

CareLink Pro Használati útmutató Tartalom v



16 A jelentéskészítéssel kapcsolatos beállítások
16 A megjeleníteni kívánt adatok kiválasztása
18 Az oszlopok sorrendjének megváltoztatása
18 A jelentéskészítéssel kapcsolatos beállítások

véglegesítése

3. fejezet 19 A Profile (Profil) munkaterület
19 Mielőtt hozzákezdene...
20 Új profilok hozzáadása
20 Betegprofilok szerkesztése
20 A beteg adatainak törlése a rendszerből
21 Kapcsolódás a CareLink Personal szoftverhez

4. fejezet 24 A hardver beállítása
24 A készülékek csatlakoztatása

5. fejezet 27 A Devices (Készülékek) munkaterület
28 Mielőtt hozzákezdene...
28 Készülék hozzáadása
28 Medtronic pumpa vagy Guardian monitor hozzáadása
30 Mérőeszköz hozzáadása
33 Készülék aktiválása és inaktiválása
34 Készülék adatainak beolvasása

6. fejezet 36 A Reports (Jelentések) munkaterület
36 Mielőtt hozzákezdene...
37 Jelentések létrehozása
37 A Reports (Jelentések) munkaterület megnyitása
37 A jelentés időszakának kiválasztása
37 Adatnaptár
38 A jelentésbe foglalandó forrásadatok kiválasztása
38 A készülékadatok ellenőrzése
39 További készülékadatok beolvasása
40 Jelentés beállításainak ellenőrzése
41 Jelentéstípusok és felvenni kívánt dátumok kiválasztása
42 Jelentések létrehozása
43 A jelentésekről
43 A Dashboard (Vezérlőpult) és az (Episode Summary) Epizód

összefoglaló
43 A Therapy Management Dashboard (Terápiakezelő)

vezérlőpult
44 Az Episode Summary (Epizód-összefoglalás)
44 Az Adherence Report (Betartási jelentés)
44 A Sensor and Meter Overview Report (Szenzor- és

mérőadatok összefoglaló) jelentés
44 A Logbook Report (Naplójelentés)
45 A Device Settings Snapshot (Készülékbeállítások pillanatképe)

CareLink Pro Használati útmutató Tartalom vi



45 A Daily Detail Report (Részletes napi jelentés)
45 Adatexportálás

7. fejezet 47 Rendszerfelügyelet
47 Szoftverfrissítések alkalmazása
48 Az automatikus frissítések kikapcsolása
48 Frissítések manuális keresése
48 Az adatbázis biztonsági mentése és visszaállítása
48 Az adatbázis biztonsági mentése
49 Az adatbázis visszaállítása
49 Teendők a rendszer elérhetetlensége esetén

8. fejezet 50 Hibaelhárítás
50 Általános alkalmazáshasználati hibák
50 Nincs kapcsolat az adatbázissal
51 Elfelejtette a rendelő CareLink Pro szoftverhez használt

jelszavát
51 Készülékleolvasási hibák
52 Jelentés-létrehozási hibák

53 Biztonsági mentéssel és visszaállítással kapcsolatos hibák
53 A szoftver eltávolítása

9. fejezet 54 Ikontáblázat

A. függelék 55 CSV-adatok
55 Oszlopadatok jelentése
57 További tudnivalók a CareLink Pro által exportált CSV-fájlokról
57 Ha az adatok nem a várt módon jelennek meg

Szószedet 58

Tárgymutató 61

CareLink Pro Használati útmutató Tartalom vii



CareLink Pro Használati útmutató Tartalom viii



1

Bevezetés

Köszönjük, hogy a Medtronic Diabetes termékét választotta a cukorbetegség hatékonyabb

kezelése érdekében. Meggyőződésünk, hogy a CareLink® Pro szoftver korszerű megoldásait és

egyszerű,  menüalapú felhasználói felületét hasznosnak fogja találni.

A CareLink Pro használatával a beteg terápiás és diagnosztikai adatait gyűjtheti össze, tárolhatja

és formálhatja jelentéssé. A szoftverrel ezenkívül a beteg által a pumpával, a mért értékekkel és a

szenzor által mért glükózértékekkel összefüggésben a CareLink® Personal rendszerbe feltöltött

adatokhoz is hozzáférhet. Ez a rendszer egy a CareLink Pro alkalmazással együttműködő webes

terápiairányító felület.

Jellemzők

A CareLink Pro egy személyi számítógépeken futtatható szoftver a diabéteszterápia irányítására az

alábbi szolgáltatásokkal:

• Betegrekordok hozhatók létre a beteg készülékéből beolvasott adatok, valamint a beteg

CareLink Personal-fiókjából beolvasott terápiaadatok tárolása céljából.

• Az inzulinpumpáktól, a monitoroktól és a vércukormérőktől kapott adatok elküldhetők a

rendszernek, menthetők, és jelentések készítéséhez is felhasználhatók.

• A szoftver képes együttműködni a CareLink Personal rendszerrel is, ezzel lehetővé téve a

beteg által abban mentett készülékadatok elérését. Mindez ideális megoldás a beteg egyes

felülvizsgálatai közötti jelentések elkészítéséhez, így nem feltétlenül van szükség a

készülékben tárolt adatok beolvasására a vizsgálatok során.

• A betegnaplóban tárolt készülékadatokból különféle kezelési jelentések hozhatók létre. Ezek

a jelentések segítenek megválaszolni a beteg együttműködésével, a kezelési sémákkal és a

kivételekkel kapcsolatos kérdéseket.

• A rendszer értesítést jelenít meg, ha letölthető és telepíthető szoftverfrissítések válnak

elérhetővé. Ily módon biztosítható, hogy mindig a legújabb funkciókat lehessen használni.
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• A Guide Me (Útmutató) funkció segítségével a CareLink Pro használatában még nem jártas

felhasználók is könnyebben eligazodhatnak, mert megjegyzéseket és tippeket nyújt a

végrehajtandó feladatokhoz.

• A szoftver teljes egészében egy integrált súgórendszer nyújt információt a különböző

területekről.

Biztonság

• A CareLink Pro jelszavas védelemmel látható el.

• A beteg CareLink Personal felületről származó adatainak átvitele SSL-alapú titkosítással

történik.

Kapcsolódó dokumentumok

A Medtronic MiniMed minden ilyen dokumentuma ebben a használati útmutatóban nem

részletezett készülékinformációt tartalmaz.

MEGJEGYZÉS: A mérőeszközökkel összefüggő, eszközspecifikus tudnivalókat a gyártók által
mellékelt dokumentáció tartalmazza.

• A Paradigm inzulinpumpa használati útmutatója

• A Guardian REAL-Time monitor használati útmutatója

• A szenzorfunkciók használati útmutatója

• A ComLink használati útmutatója

• A CareLink USB használati útmutatója

Támogatás

Ha további kérdései vannak a rendszerrel kapcsolatban, forduljon a helyi képviseletünkhöz. A

nemzetközi elérhetőségeket a következő webhelyen olvashatja:

http://www.minimed.com/contact/international-locations

Támogatott készülékek

A CareLink Pro a következő készülékektől tud adatokat fogadni.

MEGJEGYZÉS: A szoftver által támogatott készülékek némelyike nem feltétlenül érhető el

minden olyan országban, ahol a szoftver használatát engedélyezték.
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Inzulinpumpák és vércukorszint-monitorok

Medtronic MiniMed pumpák 508

Medtronic MiniMed Paradigm® sorozatú pumpák 511, 512, 712, 515, 715, 522, 722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Guardian REAL-Time monitorok
CSS-7100

CSS-7100K

Gyártó Vércukorszintmérők

Kompatibilis mérőkészülékek:
• Bayer CONTOUR® LINK

• BD Paradigm Link® vércukorszintmérő

Bayer

• CONTOUR® USB

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

LifeScan

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

BD • Logic®

A Bayer Ascensia™ DEX™ termékcsaládja, köztük a
következő kompatibilis mérőkészülékek:

• Ascensia™ DEX™

• Ascensia™ DEX™ 2

• Ascensia™ DEXTER-Z® II

• Glucometer™ DEXTER-Z®

• Ascensia™ ESPRIT® 2

• Glucometer™ ESPRIT®

• Glucometer™ ESPRIT® 2

A Bayer Ascensia™ ELITE™ termékcsaládja, köztük a
következő kompatibilis mérőkészülékek:

• Ascensia™ ELITE™

• Glucometer™ ELITE™ XL
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Gyártó Vércukorszintmérők

Abbott

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra®

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active

Kommunikációs eszközök

CareLink® USB A MiniMed Paradigm sorozatú inzulinpumpához és a
Guardian REAL-Time monitorhoz.

Paradigm Link® vércukorszint-monitor

A MiniMed Paradigm pumpához és a Guardian REAL-
Time monitorhoz. (A szükséges hardverről a Paradigm
Link® vércukorszint-monitor használati útmutatója
nyújt részletes felvilágosítást.)

ComLink
A MiniMed Paradigm pumpához és a Guardian REAL-
Time monitorhoz. (A szükséges hardverről a ComLink
használati útmutatója nyújt részletes felvilágosítást.)

Com-Station
A Medtronic MiniMed 508-as pumpához. (A szükséges
hardverről a Com-Station használati útmutatója nyújt
részletes felvilágosítást.)

Adatátviteli kábel

Külső gyártók vércukorszintmérőihez. A gyártók saját
adatátviteli kábelt mellékelnek készülékeikhez.

Megjegyzés: Ha egy mérőeszköz gyártója soros kábel
helyett USB-kábelt mellékel az adatok átviteléhez való
használatra, akkor telepíteni kell a gyártótól kapott
illesztőprogramot.

Emellett érdeklődje meg a mérőeszköz gyártójánál,
hogy az USB-illesztőprogram kompatibilis-e az Ön által
használt operációs rendszerrel. Egyes USB-
illesztőprogramoknak nincs 64 bites operációs
rendszeren használható verziója.

Helyettesítő készülékek

A rendszer újabb készülékkel történő bővítésekor a típust és a modellszámot egy listából kell

kiválasztania. Ha nem találja a szóban forgó készülék típusát és modellszámát a listában, az

alábbi táblázatból kiválaszthatja a megfelelő helyettesítő készüléket.
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A beteg által használt készülék Választható készülék

• Bayer Ascensia™ DEX™ 2

• Bayer Ascensia™ DEXTER-Z™ II

• Bayer Glucometer™ DEXTER-Z™

• Bayer Ascensia™ ESPRIT® 2

• Bayer Glucometer™ ESPRIT®

• Bayer Glucometer™ ESPRIT® 2

Bayer Ascensia™ DEX™

Bayer Glucometer™ ELITE™ XL Bayer Ascensia™ ELITE™

Precision Xceed™ Optium Xceed™

Megrendelés

A Medtronic Diabetes termékeinek megrendeléséhez forduljon a helyi képviseletünkhöz. A

nemzetközi elérhetőségeket a következő címen olvashatja:

http://www.medtronicdiabetes.com/help/contact/locations.html

MEGJEGYZÉS: A mérőeszközöket azok gyártójától rendelheti meg.

Az útmutató használata

MEGJEGYZÉS: A használati útmutatóban szoftverképernyő-minták is helyet kaptak. A
szoftver tényleges képernyőinek tartalma némileg eltérhet a jelen dokumentumban

látottaktól.

A szószedetben megtalálja a kifejezések és a funkciók meghatározását. Az útmutatóban használt

kifejezések jelentését a következő táblázat tartalmazza.

Kifejezés és stílus Jelentés

Kattintás A képernyő objektumaira a bal egérgombbal kattintva
kijelölhetők az objektumok.

Dupla kattintás A képernyő objektumaira a bal egérgombbal duplán
kattintva megnyithatók az objektumok.

Kattintás a jobb gombbal A képernyő objektumaira a jobb egérgombbal
kattintva másik ablak vagy menü jeleníthető meg.

Félkövér  szöveg
Gombot, képernyőnevet, mezőnevet vagy menüelemet
jelöl. Például: Patient > New Patient (Beteg > Új
beteg)

MEGJEGYZÉS: Egy eljáráshoz vagy lépéshez ad további információt.

FIGYELEM!
Veszélyre hívja fel a figyelmet, amely a szoftver vagy a
berendezés enyhe vagy közepes mértékű károsodását
okozhatja.

VIGYÁZAT!
Olyan lehetséges veszélyre hívja fel a figyelmet, amely
halált vagy súlyos sérülést okozhat. Esetenként
potenciális szövődményekre vagy biztonsági
szempontokra hívja fel a figyelmet.
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A felhasználó biztonsága

Alkalmazási terület

A CareLink Pro rendszer célja, hogy a cukorbetegség kezeléséhez hatékony eszközt biztosítson. A

rendszer rendeltetése az, hogy fogadja az inzulinpumpáktól, vércukorszintmérőktől és a vércukor

szintjét folyamatosan figyelő rendszerektől érkező adatokat, és azokat CareLink Pro-alapú

jelentésekké alakítsa. Ezekkel a jelentésekkel azonosíthatók a kialakult trendek, és nyomon

követhetők a napi tevékenységek (például az elfogyasztott szénhidrátok, az étkezési időpontok,

az inzulin beadásának időpontjai és a vércukorszint leolvasásának időpontjai).

Figyelmeztetések

• A rendszert csak a cukorbetegség kezelésének módját ismerő szakorvos használhatja.

• A rendszer által adott eredmények nem képezhetik orvosi tanácsadás alapját.

• A terméket kizárólag a jelen dokumentumban felsorolt támogatott készülékekkel szabad

használni. (Lásd: Támogatott készülékek 2. oldal.)

• Javasolt, hogy a beteg naponta legalább 4–6 alkalommal ellenőrizze vércukorszintjét.

• Szakorvosi egyeztetés nélkül a betegnek nem szabad módosítania a kezelés módját.

• A betegnek nem a vércukorszintszenzor eredményei, hanem a szakorvos iránymutatása és a

vércukorszint mért értékei alapján kell döntenie a kezelés mikéntjéről.
 
Ellenjavallatok

A szoftvert csak a vonatkozó táblázatban (Támogatott készülékek 2. oldal) említett készülékekkel

szabad használni. A termék csak a cukorbetegség kezelésére szolgál.

A szoftver indítása előtt zárja be a számítógépen jelenleg működő következő szoftvereket:

• CGMS® System Solutions™ szoftver (7310)

• Solutions® Pumps & Meters szoftver (7311)

• Guardian® Solutions® szoftver (7315)

• ParadigmPAL™ (7330)

• CareLink® Personal szoftver (7333)

• Solutions® szoftver a CGMS®iPro termékhez (7319)

CareLink Pro Használati útmutató   Bevezetés 6



2

Első lépések

Az alábbiak a CareLink Pro szoftver elindítását, a betegek rekordjainak megnyitását és bezárását,

valamint a rendszer minden betegére érvényes beállítások megadását mutatják be.

Mielőtt hozzákezdene...

Ha most használja először a CareLink Pro szoftvert, mindenképpen adja meg az általános

beállításokat (lásd: Általános beállítások 12. oldal). Ezek a beállítások határozzák meg, hogy

bizonyos elemek hogyan jelenjenek meg a szoftverben és a jelentésekben, és ezek segítségével

állíthatja be a rendszer internettel való kommunikációját.

Ezeket a beállításokat bármikor elvégezheti, ezért érdemes a többi beállítás megadása előtt

megismerkedni a CareLink Pro szoftverrel.

Elsődleges rendszerfeladatok

Az alábbi táblázat ismerteti a CareLink Pro első beállítása és használata során elvégzendő főbb

feladatokat. A táblázatból az is kiderül, hogy a használati útmutató melyik része foglalkozik az

adott feladattal.

Lépés Hely

Ismerkedés a CareLink Pro felhasználói felületével Navigálás a rendszerben 8. oldal

Az Ön rendelője által használt globális
rendszerbeállítások megadása Rendszerbeállítások megadása 11. oldal

Profil létrehozása minden beteg számára Új profilok hozzáadása 20. oldal

Kapcsolódás a betegek CareLink Personal-fiókjaihoz Kapcsolódás a CareLink Personal szoftverhez 21. oldal

Pumpák és mérőeszközök hozzáadása a beteg
profiljához. Készülék hozzáadása 28. oldal

Adatok beolvasása a beteghez tartozó pumpákról és
mérőeszközökről. Készülék adatainak beolvasása 34. oldal

Jelentések beállítása és elkészítése az egyes betegekről Jelentések létrehozása 37. oldal
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Lépés Hely

Rendszeres biztonsági másolat készítése a CareLink Pro
adatbázisáról Az adatbázis biztonsági mentése 48. oldal

A CareLink Pro szoftver frissítése Szoftverfrissítések alkalmazása 47. oldal

Navigálás a rendszerben

Mielőtt megkezdené a CareLink Pro használatát, érdemes megismerkednie az alkalmazás

felhasználói felületével. A felhasználói felület a menükből, egy eszköztárból, egy navigációs

sávból, munkaterületekből és egy útmutató ablakból épül fel.

A CareLink Pro megnyitása

1 Kattintson duplán a számítógép asztalán található CareLink Pro ikonra , vagy kattintson a

Windows Start menü Programs (Programok) csoportján belül megtalálható Medtronic

CareLink Pro  parancsra.

Ha a rendelői rendszer jelszó beírását kéri, megjelenik a bejelentkezési képernyő.

a. Írja be a jelszót a Password  (Jelszó) mezőbe.

MEGJEGYZÉS: A jelszavas védelem a telepítési folyamat során állítható be
választható lehetőségként.

b. Kattintson a LOGIN  (Bejelentkezés) gombra.

Megjelenik az indítóképernyő.

2 A New Patient  (Új beteg) ikonra kattintva új betegrekordot vehet fel, az Open Patient
(Betegadatok megnyitása) ikonnal pedig megnyithatja a szükséges betegrekordot a betegek

rendszerbeli listájáról.

Munkaterületek

Ha meg van nyitva egy betegrekord, a navigációs sáv valamelyik gombjára kattintva

megjeleníthető a kapcsolódó munkaterület. A felsorolt munkaterületekkel írhatók be vagy

választhatók ki a beteghez kötődő CareLink Pro-feladatok végrehajtásához szükséges adatok.

Profile (Profil): A betegadatok (például név és
születési dátum) tárolására szolgál, és lehetővé teszi a
beteg CareLink Personal-fiókjához való csatlakozást is.

Devices (Készülékek): A beteg készülékeinek
olvasásához szükséges adatok tárolására szolgál.

Reports (Jelentések): Lehetővé teszi a paraméterek
kiválasztását, valamint a beteghez létrehozandó
jelentések megadását.

Amíg nem vesz fel és nem ment egy profilt a szóban forgó beteghez, csak a Profile (Profil)

munkaterület használható. Csak a Profile (Profil) és a Devices (Készülékek) munkaterület érhető el,

amíg nem ad hozzá a beteghez készülékeket.
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Eszköztár

A CareLink Pro eszköztára lehetővé teszi a gyakran használt funkciók gyors elérését. Az eszköztár

az alábbi gombokat tartalmazza.

Gomb Név Funkció

Add Patient (Beteg hozzáadása)

Megnyitja a Profile (Profil)
munkaterületet, amelyen új
betegrekord vehető fel a
rendszerbe.

Open Patient (Beteg adatainak
megnyitása)

Megnyitja a Patient Lookup (Beteg
keresése) táblázatot, amelyben
kiválaszthatók megtekintésre a már
meglévő betegrekordok.

Guide Me (Útmutató)

Megjeleníti vagy elrejti az
útmutatót. Erre a gombra kattintva
környezetfüggő súgó jeleníthető
meg.

Betegrekordlapok

Egy adott betegrekord megnyitását követően egy a beteg nevét feltüntető lapfül jelenik meg az

eszköztár mentén. Ha egy lap aktív, akkor a kapcsolódó betegrekord és munkaterület is aktív, és

végrehajthatók a beteggel összefüggő CareLink Pro-feladatok.

Egy betegrekord aktiválásához kattintson a beteghez tartozó fülre. Betegrekord bezárásához

kattintson a fülön látható Close (Bezárás) gombra .

Az útmutató

A CareLink Pro szoftver teljes egészében segítségül hívható az útmutató, amelynek ablakában

környezetfüggő megjegyzések és tippek találhatók az aktív rendszerösszetevő használatához. Az

útmutató ablakában esetenként >> learn more  (további tudnivalók) szövegű, további
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információra utaló hivatkozások is láthatók. E hivatkozásokra kattintva az online súgó bővebb

tájékoztatást tartalmazó megfelelő része nyílik meg. Az útmutató alapértelmezés szerint

engedélyezett, de bármikor ki is kapcsolható.

Az útmutató be- és kikapcsolása

Az útmutatót a következő módszerekkel kapcsolhatja be vagy ki:

• Kattintson a Guide Me  (Útmutató) gombra. 

• Kattintson a Help > Guide Me  (Súgó > Útmutató) parancsra.

A betegek rekordjainak megnyitása

Összesen hat betegrekord lehet nyitva egyszerre. Ha még nem hozott létre betegprofilokat,

lásd: Új profilok hozzáadása 20. oldal.

1 Válassza a File > Open Patient  (Fájl > Beteg adatainak megnyitása) parancsot, vagy

kattintson az Open Patient  (Beteg adatainak megnyitása) gombra . Az alábbihoz hasonló

beteglista jelenik meg.
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MEGJEGYZÉS: Ha az az üzenet jelenik meg, hogy túl sok rekord van nyitva, a folytatás
előtt kattintson az OK gombra, majd zárjon be egy rekordot.

2 A beteg nevének vagy neve egy részének beírásával keresse meg a beteget a Find a Patient
(Beteg keresése) mezőben. Ha a beteghez tartozó sor ki van jelölve, kattintson az OPEN
(Megnyitás) gombra, kattintson duplán a lista kijelölt sorára, vagy nyomja le az ENTER

billentyűt. A billentyűzet FEL és LE nyílbillentyűivel is lépkedhet a lista elemei között.

Ekkor a beteghez tartozó Devices (Készülékek) munkaterület (ha nem állított még be

készüléket) vagy Reports  (Jelentések) munkaterület jelenik meg.

3 A beteghez tartozó Profile  (Profil) munkaterület megjelenítéséhez kattintson a navigációs

sávon található Profile  (Profil) gombra .

A betegek rekordjainak bezárása

1 Győződjön meg arról, hogy a bezárni kívánt rekord aktív (a lap ki van jelölve).

2 A következő lehetőségek közül választhat:

a. Válassza a File > Close Patient (Fájl > Betegadatok bezárása) parancsot.

b. A beteghez tartozó fülön kattintson a Close  (Bezárás) gombra .

c. Nyomja meg a Ctrl+F4 billentyűkombinációt.

Rendszerbeállítások megadása

Ezek a beállítások a rendszerben szereplő minden betegre vonatkoznak. A csak bizonyos

betegeket érintő beállításokról a következő helyen talál tudnivalókat: Jelentés beállításainak

ellenőrzése 40. oldal.

A beállítások az alábbi csoportosításban jelennek meg:

• General (Általános)

- Glucose units (Vércukor mértékegysége)

- Carbohydrate units (Szénhidrát mértékegysége)

- Communications (Kommunikáció)

- Troubleshooting (Hibaelhárítás)

• Patient Profile (Betegprofil)

- A betegek profiljain szereplő adatok kiválasztása és szerkesztése

• Patient Lookup (Beteg keresése)

- Az Open Patient (Beteg adatainak megnyitása) parancs nyomán megjelenő beteglistán

szereplő mezők sorrendjének módosítása

• Report Generation (Jelentés készítése)

- Az adattábla adatai alapján a Daily Detail (Részletes napi) jelentésben megjeleníteni

kívánt adatok

CareLink Pro Használati útmutató   Első lépések 11



Általános beállítások

A General (Általános) lapon azt adhatja meg, hogy a szoftver milyen formában jelenítsen meg

bizonyos típusú adatokat, valamint az adatátviteli beállításokat is itt választhatja ki.

1 Kattintson a General  (Általános) fülre, ha nem ez a lap van megjelenítve.

2 Válassza a Tools > Options  (Eszközök > Beállítások) parancsot. Megjelenik az alábbi ablak.

3 A választógomb segítségével jelölje ki a kívánt értéket:

- Glucose Units  (Glükóz-mértékegység): mmol/l vagy mg/dl

- Carbohydrate Units  (Szénhidrát mértékegysége): grams (gramm) vagy Exchanges

(Csereegység)

a. Ha a Carbohydrate Units  (Szénhidrát mértékegysége) beállításhoz az Exchanges
(Csereegység) értéket választotta, írja be a megfelelő számot a grams are equal to 1

Exchange  (gramm egyenlő egy csereegységgel) mezőbe.

4 Kattintással jelölje be a Chart Options > Overview Report (Diagrambeállítások, Összefoglaló

jelentés) csoport jelölőnégyzetét, vagy törölje annak jelölését. Ha a jelölőnégyzet be van

jelölve, az alkalmazás a mért vércukorszinteket vonalakkal köti össze a mérő vércukorszint-

fedőgrafikonján. (Ez a szenzor- és mérőadatok összefoglaló jelentésében megjelenő grafikon.)

5 Jelölje be a Communications (Kommunikáció) csoport alábbi jelölőnégyzeteit az

engedélyezéshez, vagy törölje azok jelölését a tiltáshoz:

MEGJEGYZÉS: A kommunikációval kapcsolatos beállítások elvégzése során vegye
figyelembe a rendelő vagy az intézmény informatikai részlegének irányelveit.

CareLink Pro Használati útmutató   Első lépések 12



- Automatically check for software updates (Szoftverfrissítések automatikus
keresése):  Kiválasztása esetén minden CareLink Pro szoftvert futtató rendszer értesítést

kap, ha van elérhető szoftverfrissítés. Ekkor az aktív felhasználók letölthetik és

telepíthetik a frissítéseket. A szolgáltatás kikapcsolásához és a szoftverfrissítések

telepítésének közvetlen irányításához törölje a jelölést a jelölőnégyzetből.

- Synchronize with Medtronic CareLink® Personal (Szinkronizálás a Medtronic

CareLink® Personal szoftverrel):  Akkor jelölje be ezt a jelölőnégyzetet, ha azt szeretné,

hogy a rendszer automatikusan szinkronizálja a betegek CareLink Personal rendszerbeli

adatait minden alkalommal, amikor megnyitja a profiljukat. Ha törli a jelölést, kézzel kell

majd szinkronizálnia minden egyes beteg adatait a CareLink Personal adataival.

6 Kattintással jelölje be a Troubleshooting (Hibaelhárítás) csoport jelölőnégyzetét, vagy törölje

annak jelölését. Ha a jelölőnégyzet be van jelölve, az alkalmazás a készülékadatok minden

beolvasásakor hibaelhárítás céljából menteni fog egy adatrekordot.

7 Az általános beállítások mentéséhez kattintson az OK gombra.

A betegprofilok beállításai

Ez a profilok tartalmát meghatározó globális beállítás. A Profiles (Profilok) munkaterület mezőit

igényei szerint beállíthatja arra, hogy azok a rendelője számára legfontosabb adatokat jelenítsék

meg. Felvehet új mezőket, eltávolíthatja a meglévőket, létrehozhat saját egyéni mezőket, és

meghatározhatja a mezőknek az ablakban elfoglalt sorrendjét.

1 Válassza a Tools > Options  (Eszközök > Beállítások) parancsot.

2 Kattintson a Patient Profile  (Betegprofil) fülre. Megjelenik az alábbi ablak.

MEGJEGYZÉS: A jelölőnégyzetek segítségével adja meg a profilon megjeleníteni kívánt

mezőket. A felfelé és lefelé mutató nyilak segítségével rendezze sorba a mezőket.
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Az adatmezők kiválasztása

1 A kívánt mezőket a jelölőnégyzetek segítségével adhatja hozzá.

MEGJEGYZÉS: A First name (Keresztnév) és a Last Name (Vezetéknév) mezőt nem lehet
eltávolítani.

2 Egy mező eltávolításához törölje a jelölést a mező melletti jelölőnégyzetből.

3 Egy mező kötelező felvételéhez jelölje be a Required  (Kötelező) oszlopban található

jelölőnégyzetet. Az összes kötelező mezőt ki kell tölteni a profil létrehozásához.

Egyéni mező hozzáadása

1 Jelölje be valamelyik üres egyéni mező bal oldalán található jelölőnégyzetet.

2 Nevezze el a mezőt (pl. Emergency Contact - Vészhelyzeti elérhetőségek). A mező ezzel a

névvel szerepel majd a beteg profilján.

3 A mező kötelezővé tételéhez jelölje be a Required (Kötelező) oszlopban található

jelölőnégyzetet.

MEGJEGYZÉS: Egyéni mező eltávolításához törölje a jelet az adott mező
jelölőnégyzetéből.

Az adatmezők sorrendjének megváltoztatása

Jelölje ki az áthelyezni kívánt mezőt, majd a felfelé és lefelé mutató nyilak ( ) segítségével

mozgassa azt. (A legfelső és a legalsó nyíl a lista tetejére, illetve aljára helyezi át az adott mezőt.)

A betegprofil beállításainak véglegesítése

Ha a Field Order (Mezősorrend) listán az egyes mezők a kívánt sorrendben szerepelnek, kattintson

az OK gombra.

A betegprofilok ekkor az Ön által megadott mezőkkel és mezősorrenddel rendelkeznek.

A betegkeresés beállításai

A Patient Lookup (Betegkeresés) táblázat használatával megkereshet és megnyithat egy

betegrekordot. A táblázat az adatbázisban létező összes beteget és az ezek profiljában

szereplő azonosító adatokat tartalmazza. Saját igényeinek megfelelően megváltoztathatja, hogy

a táblázatban mely adatok milyen oszlopsorrendben jelenjenek meg. A Patient Lookup

(Betegkeresés) táblázat testreszabásához tegye a következőket:

1 Válassza a Tools > Options  (Eszközök > Beállítások) parancsot.
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2 Kattintson a Patient Lookup  (Betegkeresés) fülre. Megjelenik az alábbi ablak.

MEGJEGYZÉS: A jelölőnégyzetek segítségével adja meg a Patient Lookup (Betegkeresés)

táblázatban megjeleníteni kívánt adatokat. A felfelé és lefelé mutató nyilak
segítségével rendezze sorba az oszlopokat.

A megjeleníteni kívánt adatok kiválasztása

A jelölőnégyzetek segítségével adja meg, hogy mely adatok jelenjenek meg (illetve ne jelenjenek

meg) a Patient Lookup (Betegkeresés) táblázatban.

Az oszlopok sorrendjének megváltoztatása

A Patient Lookup (Betegkeresés) táblázat oszlopsorrendjének megváltoztatásához jelölje ki az

áthelyezni kívánt oszlopot, majd a fel- és lefelé mutató nyilakkal  mozgassa azt. (A legfelső és

a legalsó nyíl a lista tetejére, illetve aljára helyezi át az adott adatoszlopot.)

A Column Display Order (Oszlopok megjelenítési sorrendje) csoport legfelső adatoszlopa lesz a

Patient Lookup (Beteg keresése) táblázat első oszlopa. Az alsó adatoszlop lesz a táblázat utolsó

oszlopa.

A betegkeresés beállításainak véglegesítése

Ha a Column Display Order (Oszlopok megjelenítési sorrendje) listában az egyes adatok a kívánt

sorrendben szerepelnek, kattintson az OK gombra.

A Patient Lookup (Beteg keresése) táblázat ekkor az Ön által megadott adatokkal és

oszlopsorrenddel rendelkezik.
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A jelentéskészítéssel kapcsolatos beállítások

Az adattábla a Select and Generate Reports (Jelentések kiválasztása és létrehozása) ablakban

jelenik meg, és a jelentéskészítésben játszik szerepet. A tábla a beteg készülékeiből, valamint

adott esetben a beteg CareLink Personal-fiókjából beolvasott napi adatokat tartalmazza,

melyekből megállapítható, hogy mely napokra vonatkozóan szükséges létrehozni napi részletes

jelentést. A tábla segítségével azt is megállapíthatja, hogy a többi jelentés közül melyeket kell

futtatnia.

Rendelője saját igényei szerint állíthatja be, hogy mely adatok és milyen sorrendben jelenjenek

meg ebben a táblában.

MEGJEGYZÉS: Azzal kapcsolatban, hogy ezek a beállítások hogyan lesznek az adattáblára

alkalmazva jelentéskészítéskor, a következő helyen talál információt: Jelentéstípusok és

felvenni kívánt dátumok kiválasztása 41. oldal.

1 Válassza a Tools > Options  (Eszközök > Beállítások) parancsot.

2 Kattintson a Report Generation  (Jelentés készítése) fülre. Megjelenik az alábbi ablak.

A megjeleníteni kívánt adatok kiválasztása

A jelölőnégyzetek segítségével adja meg az adattáblába felvenni és az abból eltávolítani kívánt

adattípusokat.

Az adattáblába az alábbi adatokat veheti fel.
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Oszlop neve Jelentés

№ of Meter Readings (Mérések száma) A megadott napon a megadott készülékek által
rögzített mérések száma.

Meter Readings Average (Mérések átlaga) A megadott készülékek által rögzített
vércukorszintmérések átlagértéke.

Sensor Duration (Szenzor rögzítési időtartama)
A megadott napon belüli azon időtartam, amely alatt
a szenzor adatokat rögzített. Lehetséges értékek:
(nincs), 0:05 – 24:00.

Sensor Average (Szenzor méréseinek átlaga) A szenzor által a megadott napon rögzített mérések
átlagértéke.

Highest Reading (Legnagyobb érték) A megadott napon (szenzor vagy mérőeszköz által)
rögzített legmagasabb vércukorszint.

Lowest Reading (Legkisebb érték) A megadott napon (szenzor vagy mérőeszköz által)
rögzített legalacsonyabb vércukorszint.

Avg AUC Below Target (Átlagos AUC a céltartomány
alatt)

A beteg céltartománya alá eső átlagos AUC (görbe
alatti terület).

Avg AUC Above Target (Átlagos AUC a céltartomány
felett)

A beteg céltartománya alá eső átlagos AUC (görbe
alatti terület).

Total Carbs (Összes szénhidrát)

Azoknak a szénhidrátmennyiségeknek (a legközelebbi
grammértékre vagy 0,1 csereegységre kerekített)
összege, melyeket az adott nap folyamán Bolus
Wizard-események, illetve a pumpán vagy a Guardian
készüléken lévő szénhidrátmarkerek jelentettek.

Suspend Duration (Felfüggesztés időtartama)
Az az időtartam, ameddig a pumpa az adott napon
felfüggesztett állapotban volt. Lehetséges értékek:
(nincs), 0:01 – 24:00.

№ of Rewinds (Visszatekerések száma) A visszatekerési események száma a megadott napon.

№ of Primes/Fills (Feltöltések vagy töltések száma) A feltöltési vagy töltési események adott napon
rögzített száma.

Prime/Fill Volume (U) (Feltöltési vagy töltési térfogat
(E))

Az adott nap feltöltési (vagy töltési) eseményeinél
használt inzulin teljes mennyisége.

Total Insulin (U) (Összes inzulin (E)) Az adott napon beadott teljes inzulinmennyiség a
pumpa mérései alapján.

Total Basal (U) (Összes bázis (E))
Az adott napon beadott bázisinzulin teljes mennyisége
(azaz a teljes beadott inzulinmennyiség mínusz a teljes
beadott bólusmennyiség).

Total Bolus (U) (Összes bólus (E)) Az adott napon bólusokban beadott teljes
inzulinmennyiség a pumpa mérései alapján.

Basal % (Bázis %) A bázisinzulin teljes inzulinmennyiséghez mért
százalékos aránya (egész százalékokban).

Bolus % (Bólus %) A bólusinzulin teljes inzulinmennyiséghez mért
százalékos aránya (egész százalékokban).

№ of Boluses (Bólusok száma) Az adott napon rögzített bólusesemények száma.

Bolus Wizard Events (Bolus Wizard-események) Az adott napon rögzített Bolus Wizard-események
száma.

Bolus Wizard Overrides (Bolus Wizard felülbírálásai)
Azoknak a Bolus Wizard-eseményeknek a száma,
amelyek során a beadott inzulin mennyisége eltér a
javasolt mennyiségtől.

№ of Meal Boluses (Étkezési bólusok száma)
Azoknak az adott napon rögzített Bolus Wizard-
eseményeknek a száma, amelyeknél nullánál nagyobb
szénhidrátmennyiségek voltak rögzítve.
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Oszlop neve Jelentés

№ of Correction Boluses (Korrekciós bólusok száma)
Azoknak az adott napon rögzített Bolus Wizard-
eseményeknek a száma, amelyeknél nullánál nagyobb
korrekciós mennyiségek voltak rögzítve.

№ of Manual Boluses (Kézi bólusok száma) A Bolus Wizard-eseményeken kívüli bólusesemények
száma az adott napon.

Az oszlopok sorrendjének megváltoztatása

Az adattábla oszlopsorrendjének megváltoztatásához jelölje ki az áthelyezni kívánt oszlopot, majd

a fel- és lefelé mutató nyilakkal  mozgassa azt. (A legfelső és a legalsó nyíl a lista tetejére,

illetve aljára helyezi át az adott oszlopot.)

MEGJEGYZÉS: A Column Order (Oszlopok sorrendje) lista legfelső eleme lesz az adattábla

első oszlopa. Az alsó elem lesz az adattábla utolsó oszlopa.

A jelentéskészítéssel kapcsolatos beállítások véglegesítése

Ha a Column Order (Oszlopsorrend) listában az egyes adatok a kívánt sorrendben szerepelnek,

kattintson az OK gombra.

Az adattábla ekkor az Ön által megadott adatokkal és oszlopsorrenddel rendelkezik.

CareLink Pro Használati útmutató   Első lépések 18



3

A Profile (Profil) munkaterület

A profil az orvosok által használt kórlap fedőlapjához hasonlít, és a beteg adatait (például a nevét

és a születési dátumát) tárolja. A profil szükséges a készülék adatainak összegyűjtéséhez és a

terápiás jelentések elkészítéséhez.

A Profile (Profil) munkaterület arra is alkalmas, hogy segítségével kapcsolódjon a beteg CareLink

Personal-fiókjához. Amint a kapcsolat létrejött, a beteg CareLink Personal által tárolt adataihoz a

beteg személyes jelenléte nélkül is bármikor hozzá lehet férni.

Mielőtt hozzákezdene...

A betegprofilok testreszabhatók annak érdekében, hogy csak az Ön által igényelt információkat

tartalmazzák. A további információkat lásd: A betegprofilok beállításai 13. oldal.
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Ha létre kívánja hozni a kapcsolatot a beteg CareLink Personal-fiókjával, szükség van

felhasználónévre és jelszóra is. Ezen adatok megadása a beteg személyes jelenléte mellett

történik.

Új profilok hozzáadása

Minden egyes beteg CareLink Pro rendszerbe történő felvétele előtt ki kell tölteni egy profilt.

1 Válassza a File > New Patient (Fájl > Új beteg) parancsot, vagy kattintson az Add Patient

(Beteg hozzáadása) gombra. 

Megjelenik a Profile  (Profil) munkaterület.

MEGJEGYZÉS: Mezők hozzáadásához vagy módosításához a beteg profilján kattintson a

customize fields (mezők testreszabása) feliratra. Lásd: A betegprofilok beállításai 13. oldal.

2 Töltse ki a Patient Profile  (Betegprofil) csoportban található mezőket.

3 Kattintson a SAVE  (Mentés) gombra.

A program hozzáadja az új betegprofilt a CareLink Pro adatbázisához, és egy megerősítő

üzenet jelzi, hogy a profil mentése megtörtént.

A kötelező mezők kitöltése

1 Ha egy kötelező mező nincs kitöltve a betegprofil mentésekor, egy üzenet jelenik meg a

kitöltendő mező mellett. A profil mentése csak akkor lehetséges, ha a mező ki van töltve.

2 Töltse ki a mezőt.

3 Kattintson a SAVE  (Mentés) gombra.

4 A megerősítő üzenet megjelenésekor kattintson az OK gombra.

Betegprofilok szerkesztése

1 Győződjön meg arról, hogy az adott beteghez tartozó Profile  (Profil) munkaterület meg van

nyitva.

2 Kattintson az EDIT (Szerkesztés) gombra.

3 Szükség szerint módosítsa a Patient Profile  (Betegprofil) szakasz adatait.

4 Kattintson a SAVE  (Mentés) gombra.

Egy megerősítő üzenet jelzi, hogy a profil mentése megtörtént.

A beteg adatainak törlése a rendszerből

1 Győződjön meg arról, hogy az adott beteghez tartozó Profile  (Profil) munkaterület meg van

nyitva.
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2 Ellenőrizze, hogy valóban a törölni kívánt beteg adatai szerepelnek-e képernyőn. A

betegprofil törlésével a beteg összes adata visszavonhatatlanul törlődik a CareLink Pro

adatbázisából is.

3 Kattintson a profil szinkronizálási szakasza feletti >> delete patient record (betegrekord

törlése) elemre.

Figyelmeztető üzenet jelzi, hogy a rekord törlésekor a beteg minden adata törlődni fog.

4 A beteg rekordjának törléséhez kattintson a Yes  (Igen) gombra.

Kapcsolódás a CareLink Personal szoftverhez

A beteg beleegyezésével kapcsolatot hozhat létre a beteg CareLink Personal-fiókjával. Ennek a

webalapú eszköznek a segítségével a betegek feltölthetik és tárolhatják a készülékből nyert

adatokat, valamint különböző terápiás jelentéseket futtathatnak.

Ha kapcsolódik a beteg CareLink Personal-fiókjához, hozzáférhet az ott tárolt készülékadatokhoz.

Így lehetősége van CareLink Pro-jelentések készítésére a terápiáról két vizsgálat között, valamint

kevesebbszer kell leolvasnia a készüléket a beteg látogatásai során.

Ha a betegnek még nincs CareLink Personal-fiókja, küldhet neki meghívó e-mailt, melynek

segítségével a beteg létrehozhatja saját fiókját.

Kapcsolat létrehozása meglévő fiókkal

MEGJEGYZÉS: E lépésekhez a beteg személyes jelenléte szükséges.

1 Ellenőrizze az internetcsatlakozást.

2 Nyissa meg a beteghez tartozó Profile  (Profil) munkaterületet.

3 Győződjön meg arról, hogy minden szükséges mező ki van töltve a Patient Profile
(Betegprofil) csoportban.

4 Kattintson a LINK TO EXISTING ACCOUNT (Kapcsolódás meglévő fiókhoz) parancsra.

Megjelenik a CareLink Personal bejelentkezési képernyője.

5 Kérje meg a beteget az alábbiakra:

a. Írja be a felhasználónevét és a jelszavát.

b. Kattintson a Sign In (Bejelentkezés) gombra.

Megjelenik a beteg területi és nyelvi beállításait alapul vevő Grant Access  (Hozzáférés

engedélyezése) képernyő.

6 Kérje meg a beteget az alábbiakra:

a. Olvassa el a felhasználási feltételeket (Terms of Use).

b. Jelölje be az I agree to the Terms of Use above... (Elfogadom a fent ismertetett

felhasználási feltételeket) jelölőnégyzetet.

c. Kattintson a Grant Access  (Hozzáférés engedélyezése) gombra.

d. Jelezze, ha a Thank You  (Köszönöm) képernyő megjelenik.
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7 A felhasználási feltételeket ki is nyomtathatja a beteg számára, ha a Print  (Nyomtatás)

gombra kattint. Ezzel sikeresen kapcsolódott a beteg CareLink Personal-fiókjához.

E-mail meghívó küldése

Ha meghívó e-mailt kíván küldeni a betegnek CareLink Personal-fiók létrehozása céljából,

végezze el a következő lépéseket:

1 Nyissa meg a beteghez tartozó Profile  (Profil) munkaterületet.

2 Győződjön meg arról, hogy minden szükséges mező ki van töltve a Patient Profile
(Betegprofil) csoportban.

3 Kattintson a SEND E-MAIL INVITATION TO PATIENT  (Meghívó e-mail küldése a betegnek)

gombra.

4 Győződjön meg arról, hogy a Patient Name  (Beteg neve), az Email Address  (E-mail cím) és a

Language  (Nyelv) mező helyesen van kitöltve.

5 Kattintson a SEND (Küldés) gombra.

A betegprofil állapotterületén a program megerősíti, hogy az e-mail elküldése megtörtént.

Adatok beolvasása kapcsolattal rendelkező fiókból

Ha kapcsolata van egy beteg CareLink Personal-fiókjával, a rendszer automatikusan elküldi a

fiókban lévő új adatokat a betegprofil CareLink Pro alkalmazásban történő minden

megnyitásakor.

MEGJEGYZÉS: Hogy ez biztosan megtörténjen, győződjön meg arról, hogy a Tools > Options
> General (Eszközök > Beállítások > Általános) lapon be van jelölve a Synchronize with

CareLink Personal (Szinkronizálás a CareLink Personal szoftverrel) jelölőnégyzet.

Azt, hogy a profil minden megnyitásakor megtörténjen a beteg CareLink Personal által kezelt

adatainak beolvasása, a következőképpen állíthatja be:

1 Győződjön meg arról, hogy a beteghez tartozó Profile  (Profil) munkaterület meg van nyitva,

és ellenőrizze az internetcsatlakozást.
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2 Válassza a Tools > Synchronize Patient Data  (Eszközök > Beteg adatainak szinkronizálása)

parancsot.

A szinkronizálás ikonja ( ) forogni kezd a beteghez tartozó programfülön. Amikor az ikon

megáll, a folyamat véget ért.

MEGJEGYZÉS: Ha a beteg nem kívánja a továbbiakban megosztani a CareLink Personal

rendszerbeli adatait, erről egy üzenet jelenik meg.

3 A CareLink Personal által kezelt további adatok szerepelni fognak a betegről szóló

jelentésekben.

A beteg CareLink Personal-fiókja és a CareLink Pro közötti kapcsolat
megszüntetése

A beteg CareLink Personal-fiókja és a CareLink Pro közötti kapcsolatot megszüntetheti. Ez a

lehetőség csak akkor érhető el, ha korábban a kapcsolatot létrehozta. A kapcsolat

megszüntetésével megelőzhető, hogy a CareLink Pro továbbra is adatokat kérdezzen le a

beteg CareLink Personal-fiókjából, ugyanakkor az eljárás nem érinti a beteg saját CareLink

Personal-fiókjával kapcsolatos egyéb műveleteit.

1 Nyissa meg a beteg rekordját, és váltson a Profile  (Profil) munkaterületre.

2 Kattintson az UNLINK ACCOUNT  (Fiók kapcsolatának megszüntetése) gombra.

3 A megerősítő üzenet megjelenésekor kattintson a Yes (Igen) gombra. A beteg profiljának

kapcsolata megszűnt a CareLink Pro szoftverrel.

Az állapot Not linked (Nincs kapcsolat) értékre vált, valamint a LINK TO EXISTING ACCOUNT
(Kapcsolódás meglevő fiókhoz) és a SEND E-MAIL INVITATION TO PATIENT (Meghívó e-mail

küldése a betegnek) gomb ismét megjelenik.
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4

A hardver beállítása

A készülékről történő közvetlen adatbeolvasáshoz szükség van a beteg készülékére, valamint a

készülék adatainak a számítógépre való továbbításához szükséges kábelekre és egyéb

kommunikációs eszközökre.

Ha a beteg feltöltötte a készülékeiből származó adatokat CareLink Personal-fiókjába, akkor az

adatok ehhez a fiókhoz kapcsolódva is lekérhetők. A beteg CareLink Personal-fiókjához való

kapcsolódás lépéseit lásd: Kapcsolódás a CareLink Personal szoftverhez 21. oldal.

A készülékek csatlakoztatása

Az áttekintő ábra általános képet ad arról, hogy a készülékeket hogyan kell a számítógéphez

csatlakoztatni a kommunikáció létrehozásához. A további ábrák a készülékek kommunikációjának

egyedi jellemzőit ismertetik.

Részletesebb információkért kövesse a CareLink Pro által a készülék beolvasásakor megjelenített

utasításokat.
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A hardverbeállítás áttekintése

Ezen az ábrán például látható, hogy a pumpa és a számítógép közötti kommunikáció a CareLink

USB segítségével történik. A támogatott kommunikációs eszközök listáját lásd: Támogatott

készülékek 2. oldal.

Példa soros és USB-kábellel történő csatlakoztatásra:
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Opcionális ComLink a Paradigm pumpákhoz:

Opcionális Com-Station a Medtronic MiniMed 508 pumpához:
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5

A Devices (Készülékek) munkaterület

A beteg készülékének beolvasásához szükséges adatokat (gyártó, modell, sorozatszám stb.) a

Devices (Készülékek) munkaterület tartalmazza. Következésképpen ezeket az információkat nem

kell megadnia minden alkalommal, amikor adatokat olvas le a készülékről.

A Devices (Készülékek) munkaterületen tárolt készülékek a következő két listában jelennek meg:

Active Devices (Aktív készülékek) vagy Inactive Devices (Inaktív készülékek). Készülék

hozzáadásakor az automatikusan az Active Devices (Aktív készülékek) listába kerül. Csak az Active

Devices (Aktív készülékek) listában megjelenő készülékekről olvashatók le adatok. Ezek

valószínűleg a beteg által jelenleg használt készülékek lesznek.

A beteghez tartozó egyéb készülékeket, amelyek használaton kívül vannak, az Inactive Devices

(Inaktív készülékek) listában lehet tárolni. E módszerrel megőrizhetők az információk. A

készülékeket bármikor aktiválni lehet.
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Mielőtt hozzákezdene...

Ahhoz, hogy megnyithassa a beteg Devices (Készülékek) munkaterületét, a betegnek a

rendszerben mentett profillal kell rendelkeznie. Lásd: Új profilok hozzáadása 20. oldal.

Készülék hozzáadásához vagy a készülékről történő közvetlen adatbeolvasáshoz a készüléknek

kommunikálnia kell a számítógéppel. A készülékek számítógéppel történő kommunikációjához

szükséges beállításainak leírása itt olvasható: A készülékek csatlakoztatása 24. oldal.

Készülék hozzáadása

Ha még nincs hozzáadva a készülék, az adatokat a beteg CareLink Personal-fiókjából lehet

beolvasni. E készülékeket a rendszer automatikusan felveszi a CareLink Personal és a CareLink Pro

közötti adatszinkronizáláskor.

MEGJEGYZÉS: Betegenként csak egyetlen aktív pumpa lehet a rendszerben. Újabb pumpa
hozzáadásakor a már felvett átkerül az inaktív készülékek listájába.

Medtronic pumpa vagy Guardian monitor hozzáadása

1 Győződjön meg arról, hogy a hozzáadni kívánt készülék beállítása lehetővé teszi a

kommunikációt a számítógéppel. (A kapcsolódás lépéseiről itt olvashat: A készülékek

csatlakoztatása 24. oldal.)

2 Kattintson a beteg adatait jelző fülre, vagy kattintson duplán a beteg nevére a Patient Lookup

(Betegkeresés) táblázatban.

3 Kattintson a Devices (Készülékek) gombra ( ) a beteghez tartozó Devices (Készülékek)

munkaterület eléréséhez.

4 Kattintson az ADD DEVICE (Készülék hozzáadása) gombra.

5 Válassza a Medtronic Pump/Guardian  lehetőséget. Megjelenik az Add Medtronic Pump/
Guardian  (Medtronic pumpa/Guardian hozzáadása) varázsló.
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MEGJEGYZÉS: A pumpa modellszáma a pumpa hátán vagy a pumpa állapotát jelző
képernyőn olvasható.

6 A választógomb segítségével jelölje ki a hozzáadni kívánt készüléket.

Ha a MiniMed 508 pump (MiniMed 508 pumpa) lehetőséget választotta, ugorjon a 9.

lépésre.

7 Kattintson a NEXT (Tovább) gombra. Megjelenik a Serial Number  (Sorozatszám) lap.

MEGJEGYZÉS: Ha nem adja meg a helyes sorozatszámot, hibaüzenet jelenik meg.

Tekintse át a lapon látható példákat, és győződjön meg arról, hogy a pumpa
hátoldaláról a helyes karaktereket adja meg. Szükség esetén gépelje be újra a hat

karaktert.

8 Az e lapon látható példák segítségével azonosítsa a hozzáadni kívánt készüléken lévő, hat

karakterből álló sorozatszámot. (Ha az azonosításhoz további segítségre van szüksége, a

részletekhez kattintson a >> learn more  (további tudnivalók) elemre.) Írja be a hat karaktert a

Device Serial Number  (Készülék sorozatszáma) mezőbe.

9 Kattintson a NEXT (Tovább) gombra. Az alábbihoz hasonló Communication Options
(Kommunikációs beállítások) lap jelenik meg.
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10 A Choose Port  (Port kiválasztása) legördülő menüből válassza azt a portot, amelyre a

ComLink, a Paradigm Link®, a CareLink USB vagy a Com-Station kapcsolódik az Ön

számítógépén. Ha nem biztos abban, hogy melyik port a megfelelő, válassza az Auto Detect
(or USB) (Automatikus észlelés vagy USB) lehetőséget.

11 Kattintson a NEXT (Tovább) gombra. Az alábbihoz hasonló Test Connection  (Kapcsolat

tesztelése) lap jelenik meg.

12 Kövesse a készülék által adott utasításokat, majd kattintson a TEST  (Tesztelés) gombra.

Tájékoztató üzenet jelenik meg arra vonatkozóan, hogy a kapcsolat sikeresen létrejött-e. Ha

sikeres volt, menjen a következő lépésre.

MEGJEGYZÉS: A teszt nem olvassa be a pumpa adatait, hanem ellenőrzi, hogy

megfelelő-e a kapcsolat a pumpa és a számítógép között.

Ha nem volt sikeres, ellenőrizze, hogy a készülék hardvere megfelelően csatlakozik-e a

számítógéphez. Kattintson a BACK  (Vissza) gombra a varázslóban, és ellenőrizze, hogy

helyesen adta-e meg a készülék adatait.

13 Kattintson a DONE  (Kész) gombra.

Ezzel a készüléket hozzáadta a beteghez tartozó Active Devices (Aktív készülékek) listához.

Mérőeszköz hozzáadása

1 Kattintson a beteg adatait jelző fülre, vagy kattintson duplán a beteg nevére a Patient Lookup

(Betegkeresés) táblázatban.

2 Győződjön meg arról, hogy a hozzáadni kívánt mérőeszköz kommunikál a számítógéppel. (A

kapcsolódás lépéseiről itt olvashat: A készülékek csatlakoztatása 24. oldal.)

3 Kattintson a Devices  (Készülékek) gombra a beteghez tartozó Devices (Készülékek)

munkaterület megnyitásához.

4 Kattintson az ADD DEVICE (Készülék hozzáadása) gombra.
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5 Válassza a Blood Glucose Meter  (Vércukormérő) lehetőséget. Megjelenik az Add Blood
Glucose Meter  (Vércukormérő hozzáadása) varázsló.

6 A választógomb segítségével jelölje ki a megfelelő mérőeszközmárkát.

7 Kattintson a NEXT (Tovább) gombra. Megjelenik a Meter Model  (Mérőeszközmodell) lap (a

mérőeszköz gyártójától függően a lap tartalma változhat).

8 Kattintással jelölje ki a hozzáadni kívánt mérőeszközmodellt.

9 Kattintson a NEXT (Tovább) gombra. Megjelenik a Communication Options

(Kommunikációs lehetőségek) lap.

CareLink Pro Használati útmutató   A Devices (Készülékek) munkaterület 31



MEGJEGYZÉS: Csak a hozzáadni kívánt mérőeszköz esetén érvényes lehetőségeket
kínálja fel a rendszer.

10 A Choose Port  (Port kiválasztása) legördülő menüből válassza ki azt a portot, amelyre a

ComLink, a Paradigm Link vagy a CareLink USB kapcsolódik az Ön számítógépén. Ha nem

biztos abban, hogy melyik port a megfelelő, válassza az Auto Detect (or USB) (Automatikus

észlelés vagy USB) lehetőséget.

11 Kattintson a NEXT  (Tovább) gombra. Megjelenik a Test Connection (Kapcsolat ellenőrzése)

lap.

12 Kövesse az utasításokat, majd kattintson a TEST (Tesztelés) gombra.

Amennyiben a Bayer CONTOUR® USB mérőeszközt adja hozzá, biztosítsa, hogy a Bayer

GLUCOFACTS® szoftver be legyen zárva. Ellenőrizze az itt bemutatott Windows

rendszertálcát. Ha a GLUCOFACTS ikon látható, kattintson arra a jobb egérgombbal, és

válassza az Exit  (Kilépés) lehetőséget.

Tájékoztató üzenet jelenik meg arra vonatkozóan, hogy a kapcsolat sikeresen létrejött-e. Ha

sikeres volt, menjen a következő lépésre.

Ha nem volt sikeres, ellenőrizze, hogy a készülék hardvere megfelelően csatlakozik-e a

számítógéphez. Kattintson a BACK  (Vissza) gombra a varázslóban, és ellenőrizze, hogy

helyesen adta-e meg az adatokat.

13 Kattintson a DONE  (Kész) gombra.

Ezzel a mérőeszközt hozzáadta a beteghez tartozó Active Devices (Aktív készülékek)

listához.
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Készülék aktiválása és inaktiválása

A beteghez rendelt készülékeket szükség szerint lehet mozgatni az Active Devices (Aktív

készülékek) és az Inactive Devices (Inaktív készülékek) lista között. A készüléknek aktívnak kell

lennie ahhoz, hogy adatokat lehessen beolvasni róla.

Tetszőleges számú mérőeszközt lehet felvenni az Active Devices (Aktív készülékek) listára, de csak

egyetlen pumpát lehet ott tárolni. Új pumpa hozzáadása előtt győződjön meg arról, hogy

inaktiválta a jelenleg aktív pumpát.

Készülék inaktiválása

1 Kattintson a beteg adatait jelző fülre, vagy kattintson duplán a beteg nevére a Patient Lookup

(Betegkeresés) táblázatban.

2 Kattintson a Devices  (Készülékek) gombra a beteghez tartozó Devices (Készülékek)

munkaterület megnyitásához. A készülékek helyettesítő készülékek neve alatt is

megjelenhetnek. Lásd: Támogatott készülékek 2. oldal.

3 Kattintson a >> make this device inactive  (készülék inaktiválása) lehetőségre az inaktiválni

kívánt készülék alatt. Ezzel az eszközt az Inactive Devices (Inaktív készülékek) listára tette.

Készülék újbóli aktiválása

1 Kattintson a beteg adatait jelző fülre, vagy kattintson duplán a beteg nevére a Patient Lookup

(Betegkeresés) táblázatban.

2 Kattintson a Devices  (Készülékek) gombra. A beteghez tartozó Devices (Készülékek)

munkaterület jelenik meg.

A készülékek a helyettesítő készülékek neve alatt is megjelenhetnek. Lásd: Támogatott

készülékek 2. oldal.

3 Kattintson az >> activate this device (készülék aktiválása) lehetőségre az aktiválni kívánt

készülék alatt.

Ezzel az eszközt az Active Devices (Aktív készülékek) listára tette.

Készülék törlése

A következő lépésekkel törölhet egy készüléket és a benne lévő adatokat a Devices

(Készülékek) munkaterületről és a CareLink Pro rendszerből:

1 Kattintson a beteg adatait jelző fülre, vagy kattintson duplán a beteg nevére a Patient Lookup

(Betegkeresés) táblázatban.

2 Kattintson a Devices  (Készülékek) gombra a beteghez tartozó Devices (Készülékek)

munkaterület megnyitásához.

A készülékek a helyettesítő készülékek neve alatt is megjelenhetnek. Lásd: Támogatott

készülékek 2. oldal.

3 Győződjön meg arról, hogy az eszköz az Inactive Devices  (Inaktív készülékek) listán van. Ha

nincs, kattintson az >> Inactivate this device  (Készülék inaktiválása) lehetőségre az aktuális

listán.
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4 Kattintson a >> delete this device  (készülék törlése) lehetőségre a törölni kívánt készülék

alatt. Figyelmeztető üzenet jelenik meg, mely arról tájékoztat, hogy a készülék és a benne

tárolt adatok törlődnek a rendszerből.

5 A készülék törléséhez kattintson a YES  (Igen) gombra.

A készülék és a benne tárolt adatok törlődnek a Devices  (Készülékek) munkaterületről és a

CareLink Pro rendszerből. A készülék adatait többé nem lehet jelentések készítésére

használni.

Készülék adatainak beolvasása

Az adatok beolvasásának egyik módja a beteg meglévő CareLink Personal-fiókjához való

kapcsolódás. (Lásd: Kapcsolódás a CareLink Personal szoftverhez 21. oldal.) Egy másik lehetőség az e

fejezetben leírt módon történő közvetlen beolvasás a készülékről.

A beteg készülékén tárolt adatokat akkor tudja beolvasni a CareLink Pro, ha a készülék az Active

Devices (Aktív készülékek) listán van és kommunikál a számítógéppel. Az adatok beolvasás után

felhasználhatók jelentések készítésére és a beteg terápiás kezelésének kiértékelésére. A

rendelkezésre álló jelentésekről a következő helyen olvashat rövid leírást: A jelentésekről

43. oldal.

A CareLink Pro az alábbi adatokat tudja beolvasni egy inzulinpumpából:

• A pumpa különféle beállításai, például a riasztás módja, a hangjelzés ereje és az idő

• a beadott bázisinzulin mennyisége

• bólusesemények és beadott mennyiségek

• a Bolus Wizard bejegyzései

• a feltöltési mennyiségek

• a felfüggesztési időszakok

• a szenzor adott időszakban mért glükózadatai, a szenzorral ellátott pumpákon
 
A rendszerrel a Guardian REAL-Time rendszerről is gyűjthetők adatok, például az alábbiak:

• Szenzorból származó vércukorértékek (SZG)

• a szenzor koefficiens értékei

• a szenzor kalibrációs tényezői

• étkezésmarkerek

• inzulininjekciók
 
Ezenkívül a vércukormérőkben tárolt különféle információk is feltölthetők a rendszerbe a

készülékleolvasások során.
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VIGYÁZAT! Függessze fel vagy fejezze be az ideiglenes bázisok vagy az aktív bólusok
beadását, és törölje az aktív riasztásokat. A beolvasás idejére a pumpa működését

felfüggeszti a rendszer. A beolvasás végén ellenőrizze, hogy a pumpa újra működésbe
lépett-e.

FIGYELEM! A pumpa adatainak beolvasása közben ne használja a távirányítót. Ha a pumpa
elemének töltöttsége alacsony, a pumpa nem küld adatokat a számítógépnek. Cseréljen
elemet, ha az állapotjelző alacsony töltöttséget jelez.

1 Kattintson a beteg adatait jelző fülre, vagy kattintson duplán a beteg nevére a Patient Lookup

(Betegkeresés) táblázatban.

2 Győződjön meg arról, hogy a beteg készüléke kommunikál a számítógéppel. (Lásd: A

készülékek csatlakoztatása 24. oldal.)

3 Kattintson a Devices  (Készülékek) gombra a beteghez tartozó Devices (Készülékek)

munkaterület megnyitásához.

A készülékek a helyettesítő készülékek neve alatt is megjelenhetnek. Lásd: Támogatott

készülékek 2. oldal.

4 Azonosítsa az Active Devices (Aktív készülékek) listában a készüléket, amelyről adatokat

szeretne lekérdezni, és győződjön meg arról, hogy a Choose port (Port kiválasztása)

lehetőségnél megfelelő választ adott meg.

Pumpa adatainak lekérdezéséhez az Amount of Data  (Adatmennyiség) legördülő menüből

válassza ki azt az adatmennyiséget, amelyet be kíván olvastatni a CareLink Pro rendszerrel.

5 Kattintson a READ DEVICE  (Készülék beolvasása) gombra.

6 Kövesse a készülékből származó utasításokat, majd kattintson az OK gombra.

7 A CareLink Pro frissülő folyamatjelzővel mutatja, hogy a készülék beolvasása milyen

mértékben teljesült.

Ha a készülék beolvasásakor a CANCEL (Mégse) gombra kattint, a megjelenő üzenet arra

figyelmezteti, hogy a művelet visszavonása az addig beolvasott összes adat elvesztésével jár.

A feltöltés újraindításához a READ DEVICE (Készülék beolvasása) gombra kell kattintania.

- A visszavonáshoz kattintson a YES  (Igen) gombra.

- Az adatok beolvasásának folytatásához kattintson a NO (Nem) gombra.

Ha a rendszer befejezte a készülék adatainak beolvasását, megjelenik egy a folyamat

teljesülését megerősítő üzenet.

8 Kattintson az OK gombra.

- Pumpánál kövesse az utasításokat a felfüggesztett mód megszüntetéséhez.
 
Ha a CareLink Pro nem tudja beolvasni a készülék adatait, további útmutatásért olvassa el a

Hibaelhárítás című részt.
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6

A Reports (Jelentések) munkaterület

A CareLink Pro számos jelentéstípust biztosít a diabéteszes betegek kezelésének hatékonyabb

nyomon követéséhez. Az egyes jelentésekben található adatok a beteg készülékeiből és CareLink

Personal szoftver fiókjából beolvasott adatokra épülnek.

A jelentéseket a képernyőn lehet létrehozni, közvetlenül nyomtatóra lehet küldeni, valamint TIFF

vagy PDF formátumban lehet menteni és elektronikus kórlaphoz (Electronic Medical Record)

csatolni. Egyetlen művelettel számos jelentéstípust hozhat létre.

A jelentésekben foglalt adatokat a beteg készülékéről vagy CareLink Personal-fiókjáról (esetleg

mindkettőről) lehet letölteni.

MEGJEGYZÉS: A jelentések elemeiről további részleteket és jelentésmintákat a jelentések
útmutatójában talál. A jelentések útmutatójának megnyitásához a CareLink Pro szoftver
Help (Súgó) menüjében kattintson a View Report Reference Guide (PDF) (Jelentések

útmutatójának megtekintése) parancsra, és válassza ki a megfelelő nyelvet.

Mielőtt hozzákezdene...

Ahhoz, hogy a jelentésbe bele tudjon foglalni egy adott időszakot, rendelkeznie kell a beteg

készülékének adataival arra az időszakra. Jelentéskészítés előtt szükséges lehet az is, hogy a beteg

készüléke csatlakozzon a számítógéphez, hogy az aktuális adatok lekérdezhetők legyenek.
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Jelentéskészítés előtt győződjön meg arról, hogy alaposan áttanulmányozta a Verify Report
Settings (Jelentés beállításainak ellenőrzése) lépést. Itt tudja beállítani a jelentés részleteit ahhoz,

hogy a kívánt betegadatokat tudja letölteni.

Jelentések létrehozása

A következő részekből megismerheti a rendelkezésére álló jelentéseket és megtudhatja, hogyan

hozhatja létre ezeket.

Ha már ismeri a jelentéskészítés menetét és tudja, hogy milyen jelentéseket fog készíteni,

megkezdheti a jelentések létrehozását.

A Reports (Jelentések) munkaterület megnyitása

Kattintson a beteg adatait jelző fülre, vagy kattintson az Open Patient  (Beteg adatainak

megnyitása) gombra , és kattintson duplán a beteg nevére.

Megjelenik a Reports  (Jelentések) munkaterület.

MEGJEGYZÉS: Ahhoz, hogy biztosan a legfrissebb készülékadatokkal rendelkezzen a beteg

CareLink Personal-fiókjából, kattintson a SYNC DATA (Adatszinkronizálás) gombra.

A jelentés időszakának kiválasztása

1 A jelentés(ek) időszakának módosításához a Duration  (Időtartam) legördülő menüből

válassza ki a kívánt időtartamot. (A leghosszabb időtartam 12 hét.)

2 Az időszak kezdő és záró dátumát automatikusan beállítja a rendszer, de a felhasználó

módosíthatja ezt a custom date range  (egyéni dátumtartomány) beállítással.

MEGJEGYZÉS: A megengedettnél hosszabb időszak kiválasztásakor a rendszer
hibaüzenetet küld. Módosítsa az időtartamot vagy a dátumokat.

Ha a dátumtartomány egyéni beállítását választja, kattintson a From  (Kezdő dátum) és a

Through  (Záró dátum) legördülő listára a kívánt hónap, nap vagy év kiválasztásához.

Adatnaptár

A Reports (Jelentések) munkaterület adatnaptár-területe háromhónapos időszakokra bontva

mutatja meg a jelentésbe foglalható adatokat.
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A kék sávok a készülékből származó adatokat, a narancssárga sáv pedig a kiválasztott jelentési

időszakot jelképezi. A készülékadatok és a jelentési időszak közötti átfedés azt jelenti, hogy az

adatok rendelkezésre állnak a kiválasztott jelentési időszak egy részére vagy egészére.

Az adatnaptár-területen elsőként az elmúlt három hónap adatai láthatók. A többi hónap

adatainak megtekintéséhez kattintson a hónapsáv elején vagy végén lévő nyílra .

A jelentésbe foglalandó forrásadatok kiválasztása

1 Ha a beteg olyan vércukorszintmérőt használ, amely csatlakozik a pumpájához, a mérőeszköz

VC-értékeinek jelentésbe foglalásához kattintson a következő lehetőségek egyikére:

- In the pump (Pumpa adatai):  E választás előnye, hogy elegendő a beteg pumpájának

adatait beolvasni, mert a VC-értékeket a pumpa időbélyeggel látja el, és az értékek

közvetlenül a Bolus Wizard számításaihoz kapcsolódnak. Hátránya, hogy ha

kommunikációs nehézségek vannak a pumpa és a csatlakozó mérőeszköz között, az

adott időszak VC értékei-nem fognak szerepelni a jelentésben. Hasonlóképpen az

522/722-es típusnál korábbi MiniMed Paradigm pumpáknál a Bolus Wizard számításai

által nem érintett VC-értékek szintén nem kerülnek be a jelentésbe.

- In the link meter(s) (Mérőeszköz adatai): E választás előnye, hogy a csatlakozó

mérőeszközben tárolt összes érték bekerül a jelentésbe. Hátránya, hogy a mérőeszköz és

a pumpa adatainak korrelációjához előzetesen szinkronizálni kell a pumpa és a

mérőeszköz időmérőjét. A pumpa és a csatlakozó mérőeszköz adatait külön-külön kell

beolvasni.

2 A készülék adatainak jelentésbe foglalásához jelölje ki a megfelelő készülék mellett lévő

négyzetet.

Az 1. lépésben hozott választás eredményeként kizárt készülékek adatai nem adhatók a

jelentéshez. Ennek megváltoztatásához válassza a másik (mérőeszköz) lehetőséget.

3 A készülék adatainak jelentésből történő kizárásához szüntesse meg a megfelelő készülék

mellett lévő négyzet kijelölését.

Az 1. lépésben hozott választás függvényében bizonyos kijelöléseket nem szüntethet meg.

Ennek megváltoztatásához válassza a másik (mérőeszköz) lehetőséget.

A készülékadatok ellenőrzése

1 A Reports (Jelentések) munkaterületen lévő naptáron ellenőrizze, hogy a jelentési időszakot

jelképező narancssárga sáv átfedi-e a készülékadatokat ábrázoló kék sávokat.
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2 Ha a sávok átfedik egymást a teljes jelentési időszakban, a jelentéshez szükséges adatok

rendelkezésre állnak. Kattintson a NEXT  (Tovább) gombra, és folytassa a következővel:

Jelentés beállításainak ellenőrzése 40. oldal.

3 Ha a sávok nem vagy csak kis mértékben fedik át egymást, a következőket teheti:

- Módosíthatja a jelentési időszakot.

- További készülékadatokat olvashat be.

További készülékadatok beolvasása

1 További készülékadatok beolvasásához kattintson a készülékhez tartozó READ DEVICE

(Készülék beolvasása) gombra.

Megjelenik a Read Device (Készülék beolvasása) sáv.

VIGYÁZAT! Függessze fel vagy fejezze be az ideiglenes bázisok vagy az aktív bólusok

beadását, és törölje az aktív riasztásokat. A beolvasás idejére a pumpa működését
felfüggeszti a rendszer. A beolvasás végén ellenőrizze, hogy a pumpa újra működésbe
lépett-e.

FIGYELEM! A pumpa adatainak beolvasása közben ne használja a távirányítót. Ha a

pumpa elemének töltöttsége alacsony, a pumpa nem küld adatokat a számítógépnek.
Cseréljen elemet, ha a készülék állapotjelzője alacsony töltöttséget jelez.

2 Ellenőrizze, hogy a Choose port  (Port kiválasztása) lehetőségnél megfelelő választ adott-e

meg.

A beállítás megváltoztatásához kattintson a mezőhöz tartozó legördülő listára, és válasszon

másik beállítást.

3 Ellenőrizze, hogy a készülék a számítógéphez van-e csatlakoztatva.

4 Ha a készülék pumpa, megadhatja a lekérni kívánt adatmennyiséget. Kattintson az Amount
of Data  (Adatmennyiség) legördülő menüre, és válasszon értéket.

MEGJEGYZÉS: Ha az All available data  (Minden rendelkezésre álló adat) lehetőséget
választja, a rendszer a pumpában rendelkezésre álló összes adatot beolvassa. Ezzel
felülírja a rendszerben duplán meglévő adatokat.

5 Kattintson a READ DEVICE (Készülék beolvasása) gombra. Gondosan olvassa el a megjelenő

üzenetet, mert abban fontos tudnivalókat talál a pumpa adatainak beolvasásáról.

6 Kövesse az utasításokat, majd kattintson az OK gombra.

Megjelenik a készülék beolvasását jelző folyamatsáv.

A beolvasást bármikor leállíthatja, ha a CANCEL  (Mégse) gombra kattint.
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A beolvasás végét megerősítő üzenet jelenik meg.

7 Kattintson az OK gombra.

Ekkor megjelennek a készülékadatok az adatnaptáron belül.

8 Kattintson a Reports  (Jelentések) munkaterület tetején található NEXT (Tovább) gombra.

Megjelenik a Verify Report Settings (Jelentés beállításainak ellenőrzése) lépés. Itt ellenőrizheti

jelentéskészítés előtt, hogy a betegre érvényes beállítások megfelelők-e.

Jelentés beállításainak ellenőrzése

1 Ellenőrizze, hogy megfelelők-e a Glucose Target (Vércukor célértéke) beállításai. Írja be a

megfelelő értékeket, vagy kattintson a felfelé vagy lefelé mutató nyílra a Low  (Alsó) vagy a

High (Felső) mezőben az értékek növeléséhez vagy csökkentéséhez.

MEGJEGYZÉS: A mért értékek markerei (|| |) megjelennek a felkelés és lefekvés
időtengelyén, valamint az étkezési markerek időtengelyén is. Mivel a jelentések

némelyike meghatározott étkezési időszakokra, illetve felkelési és lefekvési időpontokra
eső adatokat vesz alapul, ezért fontos, hogy a beteg Bolus Wizard-eseményeihez és
méréseihez tartozó markerek megfelelően legyenek csoportosítva.

2 Új étkezési időszak hozzáadásához kattintson az ADD MEAL  (Étkezés hozzáadása) gombra.

Létező étkezési időszak szerkesztéséhez kattintson bárhova az időtengely mentén az étkezési

időszak területén.

Ekkor az időtengely alatt található Meal Period (Étkezési időszak) szerkesztő aktívvá válik.

MEGJEGYZÉS: Összesen öt étkezési időszakot választhat. Az alapértelmezettek a reggeli,
ebéd és vacsora.

3 Írja be az adatokat, vagy a nyilak segítségével adja meg a kívánt beállításokat.

Ha a beállításokat csak erre az étkezésre kívánja alkalmazni, törölje a Use these parameters
for all of this patient's meals  (Ezen paraméterek alkalmazása a beteg összes étkezésére)

jelölőnégyzet jelölését.

- Meal Name (Étkezés megnevezése): Az étkezési időszaknak adni kívánt név.

- Meal Time Period (Étkezés ideje): Az étkezési idő kezdetét és végét jelző órák.

- Pre-Meal BG Target (mmol/L or mg/dL) (Étkezés előtti VC-célérték, mmol/l vagy
mg/dl):  A beteg étkezés előtti vércukor-céltartományának alsó és felső határa.

- Pre-Meal Analysis Period (Étkezés előtti elemzés ideje): Megadja, hogy az étkezés

előtt mennyi idővel kerüljön sor vércukorelemzésre. Az ebben az időszakban rögzített

vércukorszint-értékek a részletes jelentéselemzésbe kerülnek.

- Post-Meal BG Target (mmol/L or mg/dL) (Étkezés utáni VC-célérték, mmol/l vagy
mg/dl):  A beteg étkezés utáni vércukor-céltartományának alsó és felső határa.

- Post-Meal Analysis Period (Étkezés utáni elemzés ideje):  Megadja, hogy az étkezés

után mennyi idővel kerüljön sor vércukorelemzésre. Az ebben az időszakban rögzített

vércukorszint-értékek a részletes jelentéselemzésbe kerülnek.
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Az étkezési időszakok hosszát vagy a felkelés és a lefekvés idejét a sávok elején vagy

végén lévő fogantyúkra kattintva, azokat az időtengely mentén a kívánt helyre húzva

változtathatja meg.

MEGJEGYZÉS: Az étkezési időszakok között nem lehet átfedés, de kezdő és záró
időpontjuk révén határaik egybeeshetnek. Az étkezési időszakoknak legalább 60

perceseknek kell lenniük.

4 Ha ezeket a beállításokat kívánja alkalmazni a beteg összes étkezésére, jelölje be a Use these

parameters for all of this patient’s meals (Ezen paraméterek alkalmazása a beteg összes

étkezésére) jelölőnégyzetet.

5 Az étkezési időszak létrehozásának vagy szerkesztésének végén kattintson a SAVE  (Mentés)

gombra.

6 Étkezési időszak eltávolításához kattintson a DELETE MEAL  (Étkezés törlése) gombra. Amikor

a rendszer megerősítést kér, kattintson a DELETE  (Törlés) gombra.

7 A CareLink Pro képes tárolni az ehhez a beteghez megadott beállításokat a következő

jelentéskészítéshez. Az adott beteghez tartozó beállítások mentéséhez kattintson a SAVE
SETTINGS (Beállítások mentése) gombra.

8 Kattintson a Reports  (Jelentések) munkaterület tetején található NEXT (Tovább) gombra.

Megjelenik a folyamat Select and Generate Reports (Jelentések kiválasztása és létrehozása)

lépése. A képernyőn a jelentéstípusok listája és egy adattábla látható, melyek segítségével

kiválaszthatja, mely napok adatait veszi fel és melyeket hagyja ki a részletes napi

jelentésekből.

MEGJEGYZÉS: Az adattábla megjelenésének módosításához kattintson a >> customize
columns (oszlopok testreszabása) elemre. Lásd: A jelentéskészítéssel kapcsolatos beállítások

16. oldal.

9 A képernyőn látható tartalom kinyomtatásához kattintson a PRINT  (Nyomtatás) ikonra .

Jelentéstípusok és felvenni kívánt dátumok kiválasztása

1 Jelölje be a jelentéslistába foglalni kívánt jelentés(ek) mellett lévő jelölőnégyzeteket.
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MEGJEGYZÉS: A Dashboard/Episode Summary report (Vezérlőpult/Epizód összefoglaló
jelentés) jelölőnégyzet nem érhető el, amennyiben a kiválasztott időtartamban ötnél

kevesebb napra vannak szenzor- és pumpaadatok, vagy ha az adott időszakban az
adatok a Guardian monitortól származnak.

2 Ha az adott jelentési időszakban többször is beolvasták a pumpa vagy a Guardian monitor

adatait, több pillanatkép is létezhet a készülékről:

a. Győződjön meg arról, hogy a Device Settings Snapshot  (Készülékbeállítások

pillanatképe) jelölőnégyzet be van jelölve.

b. Kattintson a legördülő nyílra, majd válassza ki a pillanatkép dátumát és idejét.

- Pumpa:  Válasszon pillanatképet a beteg pumpájából.

- Guardian:  Válasszon pillanatképet a beteg Guardian monitorából.

Ha a mezők bármelyike szürke, akkor nem áll rendelkezésre pillanatkép a jelentési

időszakra.

3 Görgesse végig az adattáblát, és tekintse át a rendelkezésre álló napi jelentéseket.

- Mindegyik oszlopban rendezheti az adatokat. Az oszlop fejlécére kattintva növekvő sorba

rendezheti az adatokat. Ismét az oszlop fejlécére kattintva csökkenő sorba rendezheti az

adatokat.

MEGJEGYZÉS: Nem lehet kiválasztani egy bizonyos napot, ha nincs adat arra a napra.

4 Jelölje be az adattáblasorok jelölőnégyzeteit azon dátumok mellett, amelyekre Daily Detail

(Napi részletek) jelentést kér.

- Az összes napi jelentést felveheti vagy kihagyhatja egyetlen kattintással, ha az adattábla

tetején a jelölőnégyzetek oszlopa fölötti jelölőnégyzetre kattint.

Jelentések létrehozása

1 A jelentések kiválasztásának ellenőrzése után kattintson a GENERATE REPORTS  (Jelentések

létrehozása) gombra a Reports (Jelentések) munkaterület tetején.

Megjelenik a lehetőségek listája.

2 Válassza a jelentés(ek) megtekintésének, nyomtatásának vagy mentésének lehetőségét.

Ha a Preview  (Megtekintés) lehetőséget választotta, a Preview  (Megtekintés) ablak jelenik

meg.

3 A nyilakra kattintva végigböngészheti a többoldalas jelentéseket.

4 Kattintson a Preview  (Megtekintés) ablak tetején lévő gombok egyikére a jelentés(ek)

mentéséhez vagy nyomtatásához.

5 Az ablak bezárásához kattintson az ablak jobb felső sarkában található Close  (Bezárás)

gombra .
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A jelentésekről

Az alábbiakban az egyes jelentések leírását olvashatja. A jelentések elemeiről további részleteket

és jelentésmintákat a jelentések útmutatójában talál. A jelentések útmutatóját a CareLink Pro

alkalmazásból érheti el:

1 Help > View Report Reference Guide (PDF)  (Súgó > A jelentések PDF formátumú

útmutatójának megtekintése).

2 Válasszon nyelvet a jelentések útmutatójának megtekintéséhez.
 
A CareLink Pro jelentéseinek közös jellemzői:

• Jelentés fejléce  – A jelentés fejléce azonosító adatokat tartalmaz, például a jelentés nevét, a

beteg nevét és az adatok forrását.

• Szénhidrátok és vércukorszint – A grafikonokon és diagramokon a szénhidrátegységek

dőlten, a vércukorszintegységek félkövéren jelennek meg.

• Hétvége adatai – A hétvége napjai félkövéren jelennek meg a könnyebb azonosítás

érdekében.

• Jelmagyarázat  – A jelentések végén jelmagyarázat látható. A szimbólumok több jelentésben

is előfordulhatnak, de a jelentések jelmagyarázatai egyediek.

A Dashboard (Vezérlőpult) és az (Episode Summary) Epizód összefoglaló

A Dashboard and Episode Summary (Vezérlőpult és Epizód összefoglaló) egy kétoldalas jelentés,

melynek célja, hogy kiválasztott időszakra összegzést adjon a beteg általános glikémiás

kontrolljáról. A jelentés első oldalának a címe a Therapy Management (Terápiakezelő) vezérlőpult,

míg a második oldal az Episode Summary (Epizód összefoglaló). Ezen oldalak leírása külön-külön

az alábbiakban olvasható.

A Therapy Management Dashboard (Terápiakezelő) vezérlőpult

A Therapy Management Dashboard (Terápiakezelő vezérlőpult) lehetővé teszi a glikémiás kontroll

általános szintjének a napszakonkénti megtekintését. A Dashboard (Vezérlőpult) oldala ábrázolja

a szenzorglükóz átfedő nyomait, valamint az inzulintermelési információkat a napi grafikonon. A

Dashboard (Vezérlőpult) továbbá az éjszakai időszakokat és az étkezésekhez közeli időpontokat is

mutatja, így segít a glikémiás kontroll felmérésében étkezések előtt és után. E grafikonok

segítségével vizuálisan megkülönböztethetők az olyan kulcsfontosságú klinikai minták, mint a

magas vércukorszint, valamint az alacsony vércukorszint és a glikémiás kontroll változásai az

általános grafikus nézeten belül. A Dashboard (Vezérlőpult) magában foglalja az olyan alacsony és

magas vércukorszinttel összefüggő minták statisztikai elemzését, melyek a nap adott szakaiban

ismételten előfordulnak.

Továbbá a Dashboard (Vezérlőpult) lehetővé teszi a napszakonkénti glikémiás kontrol és terápiát

módosító, lényeges tényezők – így a bázisséma, az inzulin-felszívódás, az inzulin-érzékenység és a

szénhidrátarányok – közötti összefüggések megállapítását. Ezzel kevésbé van szükség az
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események korrelációinak manuális módszerű megállapítására több jelentés viszonylatában.

Végül a Dashboard (Vezérlőpult) a pumpa és a szenzor használatának az általános statisztikáit is

megmutatja.

Az Episode Summary (Epizód-összefoglalás)

Az Episode Summary (Epizód-összefoglalás) oldal az alacsony és magas vércukorszinttel

jellemezhető epizódok részleteit mutatja be. Kiemeli a legkritikusabb epizódokat, valamint a

további vizsgálatok szempontjából érdekes, összefüggő események gyakoriságát. Adott esettől

függően a jelentés számba veszi az alacsony és magas vércukorszint változásainak az általánosan

ismert okait, illetve a terápia tekintetében is mérlegelésnek ad teret.

Végül az Episode Summary (Epizód-összefoglaló) általános megállapításokat ad az inzulinpumpa,

valamint a CGM és BG mérőeszköz alkalmazásával kapcsolatos, főbb magatartásbeli vagy

megfelelési intézkedések tekintetében. Ezek a megállapítások nem feltétlenül kapcsolódnak

egyes epizódokhoz.

Az Adherence Report (Betartási jelentés)

Az Adherence Report (Betartási jelentés) az inzulinpumpák és szenzorok használatát leíró

adatokat szolgáltat, és megmutatja a beteg viselkedését a terápiával szemben. A következő

kérdésekre ad választ: volt-e elegendő adat annak pontos megítélésére, hogy a beteg miként

használja inzulinpumpáját és szenzorát, amennyiben ez a kérdés vonatkozik rá? Azt a kérdést is

megválaszolja, hogy betartja-e a beteg a terápiás utasításokat. Azt is megmutatja, hogy

szükséges-e beszélnie a beteggel arról, hogyan kezeli a cukorbetegségét.

A Sensor and Meter Overview Report (Szenzor- és mérőadatok összefoglaló)
jelentés

A Sensor and Meter Overview Report (Szenzor- és mérőadatok összefoglaló jelentése) grafikus

képet ad a beteg mért napi vércukorszintjéről és az átlagértékekről, a nap 24 órájáról óránkénti

bontásban, valamint arról, hogy ezek miként viszonyulnak a beteg étkezési és alvási szokásaihoz.

A jelentés a beteg vércukorszintjét és inzulinhasználatát tükröző statisztikát is tartalmaz.

Ha vannak szenzoradatok, akkor a rendszer azokról hasonló elemzést készít, mint ennek a

jelentésnek az első oldala. Ha nincsenek szenzoradatok, a jelentés első oldalán a mérőeszköz

adatainak elemzése látható.

A jelentés utolsó oldalai a beteg napi glikémiás, szénhidrát- és inzulinkontrolljának szintjét és

minőségét mutatják. Az oldalanként legfeljebb 14 nap adatát mutató lapok jelzik, miként változik

naponta ez a kontroll a jelentési időszakban.

A Logbook Report (Naplójelentés)

A Logbook Report (Naplójelentés) a jelentési időszak napjain a mérőeszköz által mért vércukor-,

szénhidrát- és inzulinadatokat mutatja. Az óránként rögzített eseménynapló mellett tartalmazza a

napi adatok átlagát és összegzését is. Mindegyik oldal legfeljebb 14 nap adatát tartalmazza. Ha a

jelentési időszak hosszabb 14 napnál, a rendszer további oldalakat ad a jelentéshez.

CareLink Pro Használati útmutató   A Reports (Jelentések) munkaterület 44



A Device Settings Snapshot (Készülékbeállítások pillanatképe)

A Device Settings Snapshot Report (Készülékbeállítások pillanatképe jelentés) a pumpa vagy a

Guardian REAL-Time monitor adott dátumra és időpontra érvényes beállításainak pillanatképét

tartalmazza. Ennek segítségével értelmezheti a többi jelentést, vagy csak dokumentálhatja a

betegre érvényes beállításokat.

A pumpa vagy a monitor beállításait csak a készülékek beolvasásakor lehet rögzíteni. Ha a

készülék adatait nem olvasták be a jelentési időszakban, a beállítások nem állnak

rendelkezésre.

A Daily Detail Report (Részletes napi jelentés)

A Daily Detail Report (Részletes napi jelentés) megmutatja a beteg vércukorszintjét,

szénhidrátmennyiségeit és inzulinfogyasztását a kiválasztott napra. Az adattáblán kiválasztott

mindegyik napról külön jelentés készül.

A Daily Detail Report (Részletes napi jelentés) megmutatja a kiválasztott nap összes részletét.

Segítségével egy adott napra összpontosíthat, ha úgy érzi, hogy azon a napon a beteg terápiája

szempontjából fontos esemény történt.

Adatexportálás

A CareLink Pro lehetőséget ad az által beolvasott és tárolt készülékadatok exportálására. Ennek

segítségével statisztikai célokra vagy speciális jelentések és diagramok készítéséhez gyűjtheti

össze a beteg összes készülékadatát. A .csv fájl importálható a Microsoft Excel alkalmazásba vagy

egyes klinikai statisztikai programokba a további adatkezeléshez.

A .csv fájl a készülék műveleteit rögzítő adatokat tartalmaz. Például megjeleníti a mért értékek

rögzítését, a mérőeszközzel mért érték pumpa általi fogadását vagy a bázisinzulin változását.

MEGJEGYZÉS: Ez olyan speciális szolgáltatás, amelyhez szükséges a készülékből származó

nyers adatok ismerete. Ismerni kell azt a szoftvert is, amelybe a .csv fájlt importálja.

A CareLink Pro exportálási szolgáltatását a következő lépésekkel veheti igénybe:

1 Kattintson a beteg adatait jelző fülre, vagy kattintson az Open Patient (Beteg adatainak

megnyitása) gombra , és kattintson duplán a beteg nevére.

2 Ellenőrizze, hogy megjelenik-e a Reports  (Jelentések) munkaterület.

3 A Duration (Időtartam) vagy a From/Through (Kezdő dátum/Záró dátum) mezőkkel állítsa

be a dátumokat és a jelentés hosszát.

A leghosszabb választható időtartam 12 hét.

4 Kattintson az export selected data (kiválasztott adatok exportálása) hivatkozásra.

Ekkor megjelenik az Export Data to CSV File (Adatok exportálása CSV-fájlba)

párbeszédpanel.

5 Lépjen a számítógép ama mappájára, amelyben a .csv fájlt tárolni szeretné. Ha módosítani

szeretné a fájl nevét, írja be a kívánt nevet a File name  (Fájlnév) mezőbe.
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6 Kattintson a SAVE  (Mentés) gombra.

MEGJEGYZÉS: A CSV-fájlban megjelenő adatokról a CSV-adatokat ismertető függelék ad

részletes tájékoztatást.

Ezzel mentette a .csv fájlt a számítógépen a kiválasztott helyre. Ezek után a fájltípust

támogató bármelyik programba importálhatja azt.

CareLink Pro Használati útmutató   A Reports (Jelentések) munkaterület 46



7

Rendszerfelügyelet

Fontos, hogy rendszeresen készítsen biztonsági másolatot a CareLink Pro-adatbázisról. Az

adatbázis a beteg rekordjaiban összegyűlt összes rendszeradatot tárolja, így a profiladatokat, a

készülékből nyert adatokat és a jelentésbeállításokat is.

Fontos az is, hogy a CareLink Pro legújabb verziójával rendelkezzen. Rendszeres időközönként

jelennek meg frissített verziók, amelyek fontos újításokat tartalmazhatnak. Választhat, hogy Ön

kívánja ellenőrizni, hogy vannak-e új frissítések, vagy értesítést szeretne kapni azok

megjelenéséről.

Szoftverfrissítések alkalmazása

A CareLink Pro szoftverhez alkalomszerűen jelennek meg frissítések. Ha megjelenik egy

frissítésről tájékoztató értesítés, a legújabb szoftverkiadás letöltéséhez hajtsa végre az alábbi

lépéseket.

MEGJEGYZÉS: A szoftverfrissítések telepítése előtt az adatbázisról biztonsági másolatot kell
készíteni. Lásd: Az adatbázis biztonsági mentése 48. oldal.

1 Győződjön meg arról, hogy a számítógép kapcsolódik az internetre.

2 Ha van elérhető frissítés a CareLink Pro szoftverhez, megjelenik a CareLink Pro Update

(CareLink Pro-frissítés) üzenet. Az üzenet felajánlja a frissítés letöltésére szolgáló

lehetőséget.

3 Kattintson a DOWNLOAD  (Letöltés) gombra. (Ha a CANCEL (Mégse) gombra kattint, a

frissítési üzenet bezáródik. Ez esetben a frissítést egy későbbi időpontban is letöltheti.)

Megjelenik egy az adatbázis biztonsági mentését felajánló figyelmeztető üzenet.

4 Az adatbázis biztonsági másolatának létrehozásához kattintson a YES  (Igen) gombra (erről az

eljárásról lásd: Az adatbázis biztonsági mentése 48. oldal). Kattintson a NO (Nem) gombra, ha

már készített biztonsági másolatot.

A CareLink Pro új verziójának letöltését egy üzenet megjelenése jelzi.
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5 Ha meg kívánja kezdeni a CareLink Pro legújabb verziójának használatát, a szoftveralkalmazás

bezárásához, majd újbóli megnyitásához kattintson a YES  (Igen) gombra. Kattintson a NO
(Nem) gombra, ha a CareLink Pro használatát nem kívánja azonnal megkezdeni.

Az automatikus frissítések kikapcsolása

Ha nem szeretné megkapni a CareLink Pro frissítéseiről szóló automatikus értesítéseket,

kövesse az alábbi lépéseket:

1 Válassza a Tools > Options (Eszközök > Beállítások) parancsot.

2 Kattintson a General  (Általános) fülre.

3 A Communications (Kommunikáció) csoportban törölje az Automatically check for software

updates (Szoftverfrissítések automatikus keresése) jelölőnégyzet jelölését.

Frissítések manuális keresése

Manuálisan bármikor ellenőrizheti, hogy vannak-e elérhető frissítések a CareLink Pro

szoftverhez.

MEGJEGYZÉS: A szoftverfrissítések alkalmazása előtt az adatbázisról biztonsági másolatot

kell készíteni. Lásd: Az adatbázis biztonsági mentése 48. oldal.

1 Győződjön meg arról, hogy a számítógép kapcsolódik az internetre.

2 Válassza a Tools > Check for Software Updates (Eszközök, Szoftverfrissítések keresése)

lehetőséget.

3 Ha nincs elérhető frissítés, a program megjelenít erről egy üzenetet. Ha van elérhető frissítés,

megjelenik a CareLink Pro Update üzenet.

4 Kövesse a következő részben leírt eljárást: Szoftverfrissítések alkalmazása 47. oldal.

Az adatbázis biztonsági mentése és visszaállítása

Célszerű egy szabályos időközönkénti ütemezést beállítani az adatbázis biztonsági mentésének

végrehajtásához. Ezzel biztosítható a rendszeresség, és minimalizálható az adatvesztés

kockázata.

Adatbázis biztonsági mentése vagy visszaállítása esetén a program figyelmezteti, ha más

számítógépeken a szoftvert használó aktív felhasználókat észlel.

Az adatbázis biztonsági mentése

Az alábbi lépésekkel a kívánt helyen elkészítheti az aktuális adatbázis biztonsági másolatát.

1 Győződjön meg arról, hogy az összes rekord be van zárva.

2 Válassza a Tools > Backup Database  (Eszközök > Adatbázis biztonsági mentése)

menüpontot.
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MEGJEGYZÉS: Az adatbázis biztonsági másolata hálózati meghajtóra vagy cserélhető
adathordozókra (DVD-re, CD-re, USB-meghajtóra stb.) egyaránt menthető.

3 Lépjen a számítógépnek arra a mappájára, amelybe menteni szeretné a biztonsági másolatot.

Ha módosítani szeretné a biztonsági másolat fájljának nevét, írja be a kívánt nevet a File
name  (Fájlnév) mezőbe.

4 Kattintson a Save  (Mentés) gombra. Az adatbázis mentése során egy folyamatsáv látható.

A biztonsági mentés befejeződéséről egy üzenet tájékoztatja.

5 Kattintson az OK gombra az üzenet bezárásához.

Az adatbázis visszaállítása

Előfordulhat, hogy az aktuális adatbázist le kell cserélni, ha az már nem érhető el vagy nem

használható. Minél aktuálisabb a biztonsági másolat, annál kevesebb adat vész el az adatbázis

cseréje esetén.

FIGYELEM! Az adatbázis biztonsági másolattal történő visszaállítása esetén a kiválasztott
biztonsági másolat készítése óta létrehozott minden adat elvész.

Az alábbi lépésekkel kiválaszthatja azt a biztonsági másolatot, amelyre le kívánja cserélni az

aktuális adatbázist.

1 Győződjön meg arról, hogy az összes rekord be van zárva.

2 Válassza a Tools > Restore Database  (Eszközök, Adatbázis visszaállítása) parancsot.

3 Jelölje ki azt a biztonságimásolat-fájlt, amelyet az aktuális adatbázis lecseréléséhez használni

kíván (ez általában a legújabb fájl).

4 Kattintson az Open (Megnyitás) gombra. Ekkor megjelenik egy arra figyelmeztető üzenet,

hogy az adatbázis visszaállításának folytatása adatvesztést okozhat.

5 A folytatáshoz kattintson az OK gombra. Az adatbázis visszaállítása során egy folyamatsáv

látható.

A visszaállítás befejeződéséről egy üzenet tájékoztatja.

6 Kattintson az OK gombra az üzenet bezárásához.

Teendők a rendszer elérhetetlensége esetén

Ha úgy próbálja elindítani a rendszert, hogy közben egy másik felhasználó biztonsági mentést

vagy visszaállítást végez, megjelenik egy arról tájékoztató üzenet, hogy a rendszer nem érhető el.

A feladat befejeződéséig nem érheti el a rendszert.

A következő lehetőségek közül választhat:

• Várjon, amíg a folyamat befejeződik és a rendszer elérhetővé válik.

• Kattintson a CANCEL  (Mégse) gombra a kilépéshez, és próbálkozzon újra később.
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Hibaelhárítás

Ez a fejezet segítséget nyújt a CareLink Pro szoftver használata során esetleg előforduló hibák

megoldásához, továbbá a CareLink Pro esetleg szükségessé váló eltávolításához is útmutatást

nyújt.

Általános alkalmazáshasználati hibák

Ha megkísérel letölteni egy szoftverfrissítést az interneten keresztül, előfordulhat, hogy

tájékoztató üzenet jelenik meg arról, hogy nincs ehhez elegendő jogosultsága. A CareLink Pro

frissítéseinek letöltéséhez rendszergazdai jogosultságokkal kell rendelkeznie.

1 Zárja be a CareLink Pro alkalmazást, és indítsa újra a számítógépet.

2 Kérjen meg egy rendszergazdai jogosultságokkal rendelkező felhasználót, hogy jelentkezzen

be a számítógépre.

3 Kövesse a következő részben található utasításokat: Szoftverfrissítések alkalmazása 47. oldal.

Nincs kapcsolat az adatbázissal

Egy az adatbázissal való kapcsolat megszakadását jelző hibaüzenet az alábbiak egyikéről

tájékoztat:

• The database has been moved. The database must be located in the same place that was

selected during installation of the CareLink Pro software. If it has been moved, it must be

moved back to the location selected during installation. (Az adatbázist áthelyezték. Az

adatbázisnak a CareLink Pro szoftver telepítése során megadott helyen kell lennie. Ha azt

időközben áthelyezték, vissza kell helyezni a telepítés során kiválasztott helyre.)

• You are not connected to the network drive where the database is located. If the database is

located on a network drive, the network may occasionally experience problems that prevent

you from accessing the drive. Contact your computer support department for help in

reconnecting to the network drive where the database is located. (Nem kapcsolódik az

adatbázisnak helyet adó hálózati meghajtóhoz. Ha az adatbázis egy hálózati meghajtón

található, előfordulhat, hogy időnként problémák lépnek fel a hálózattal kapcsolatban,
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melyek megakadályozzák a meghajtó elérését. Az adatbázist tartalmazó hálózati

meghajtóhoz való ismételt csatlakozáshoz kérje az informatikai támogatási részleg

segítségét.)

Elfelejtette a rendelő CareLink Pro szoftverhez használt jelszavát

Ha senki sem emlékszik a rendelő által a CareLink Pro szoftverbe való bejelentkezéshez használt

jelszóra, újra kell telepíteni a CareLink Pro szoftvert, és létre kell hozni egy új adatbázist. A szoftver

újratelepítését követően nem érhetők el a korábbi adatbázisban található betegadatok. Az új

telepítés során létrehozott jelszót helyezze biztonságos helyre valahol az irodában, hogy a

jövőben ne veszítsen el adatokat.

Készülékleolvasási hibák

Hiba Magyarázat

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port.
(A kiválasztott soros portot nem lehetett megnyitni.
Előfordulhat, hogy egy másik művelet folyamatban
van a porton. Várjon, amíg a port elérhetővé válik,
vagy válasszon egy másik portot.)

Győződjön meg arról, hogy a kiválasztott
kommunikációs portot nem használja egy másik
program, vagy válasszon egy másik portot.
Próbálkozzon a számítógép újraindításával, majd a
készülék ismételt leolvasásával. Előfordulhat, hogy a
porthoz csatlakoztatott hardvereszköz (kábel stb.) vagy
maga a port meghibásodott. A probléma
meghatározásához csatlakoztassa a hardvereszközt egy
másik porthoz, és kísérelje meg újra a készülék
leolvasását.

Auto Detect could not find the device on any
available port. Please check the cable connection,
device battery & status and try again, or try specifying
a serial port. (Az automatikus észlelési szolgáltatás
egyik elérhető porton sem észlelte a készüléket.
Ellenőrizze a kábelkapcsolatot, valamint a készülék
telepét és állapotát, majd próbálkozzon újra, vagy
adjon meg egy soros portot.)

Ellenőrizze a kábel és a számítógép közötti
kapcsolatot, és győződjön meg arról, hogy a készülék
telepének töltöttsége megfelelő. Ha igen, az
automatikus észlelés választása helyett adja meg a
számítógép azon soros portját, amelyhez a kábel
csatlakozik.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Az eszköz nem található a
kiválasztott soros porton. Ellenőrizze a
kábelkapcsolatot, valamint a készülék telepét és
állapotát. Ezután próbálkozzon újra, válasszon egy
másik portot, vagy próbálja automatikus észleléssel
megkeresni a készüléket.)

Ellenőrizze a kábel és a számítógép közötti
kapcsolatot, és győződjön meg arról, hogy a készülék
telepének töltöttsége megfelelő. Ha igen, válasszon
egy másik soros portot a számítógépen, vagy válassza
az automatikus észlelést.

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and
try again. (Nem lehet kommunikálni a készülékkel.
Győződjön meg arról, hogy a megfelelő készülék van
csatlakoztatva, illetve kiválasztva, ellenőrizze a
kábelkapcsolatot, valamint a készülék telepét és
állapotát, majd próbálkozzon újra.)

Ellenőrizze a készülékleolvasáshoz kiválasztott
beállításokat, köztük a készülék nevét, a sorozatszámot
és a kapcsolat típusát. Győződjön meg arról is, hogy a
készülék, a kábel és a számítógép megfelelően
csatlakozik egymáshoz. Ellenőrizze, hogy megfelelő-e a
készülék teleptöltöttsége és riasztási állapota. Kísérelje
meg újra a leolvasást.

Unexpected response... retrying (n%) (Váratlan válasz...
újrapróbálkozás (n%))

Nem a várt érték lett beolvasva a készülékről. A
rendszer visszavonásig vagy a sikeres kommunikáció
létrejöttéig folyamatosan újra megkísérli a
kommunikációt.
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Hiba Magyarázat

The link device was found, but the device
(<sorozatszám>) is not responding. Please verify the
device’s serial number, place the device closer to the
link device to minimize signal interference, check
device battery and status. (A rendszer megtalálta az
összeköttetési eszközt, de a készülék (sorozatszám)
nem válaszol. Ellenőrizze a készülék sorozatszámát, az
interferencia minimalizálása érdekében helyezze a
készüléket minél közelebb az összeköttetési eszközhöz,
valamint ellenőrizze a készülék telepét és állapotát.)

Ellenőrizze, hogy helyesen van-e megadva a
sorozatszám. Ha nem, adja meg a helyes
sorozatszámot. Ha helyes sorozatszám van megadva,
próbálkozzon azzal, hogy közelebb helyezi az
összeköttetési eszközt a kommunikációs eszközhöz.
Helyezze az összeköttetési eszközt és a kommunikációs
eszközt minél távolabb az esetleges
interferenciaforrásoktól (például más rádiófrekvenciás
készülékektől). Ellenőrizze a telep töltöttségét,
valamint inzulinpumpa adatainak feltöltése esetén a
pumpa leadási állapotát is.

This pump is delivering a temp basal. Please cancel
the temp basal or wait until it completes, and then try
again. (Ez a pumpa éppen egy ideiglenes bázis
beadását hajtja végre. Vonja vissza az ideiglenes
bázist, vagy várja meg, amíg az befejeződik, és
próbálkozzon újra.)

Az olvasni kívánt pumpa éppen egy ideiglenes bázis
beadását hajtja végre. Várja meg, amíg az ideiglenes
bázis befejeződik, vagy vonja vissza az ideiglenes
bázist, és olvassa le a pumpát.

This device has active errors or alarms. Please clear
the alarms and try again. (A készülékhez aktív hibák
vagy riasztások kapcsolódnak. Törölje a riasztásokat,
majd próbálkozzon újra.)

A pumpához aktív riasztások tartoznak, melyek
megakadályozzák a pumpa leolvasását. A riasztások
törléséhez olvassa el a riasztásokra vonatkozó
utasításokat. Törölje a riasztásokat, majd kísérelje meg
ismét a pumpa leolvasását.

This pump is delivering a bolus. Please cancel the
bolus or wait until it completes, and then try again.
(Ez a pumpa éppen egy bólus beadását hajtja végre.
Vonja vissza a bólust, vagy várja meg, amíg az
befejeződik, és próbálkozzon újra.)

Az olvasni kívánt pumpa éppen egy bólus beadását
hajtja végre. Várja meg, amíg a bólus befejeződik,
vagy vonja vissza a bólust, és olvassa le a pumpát.

The device returned invalid entries; all data read will
be discarded. (A készülék érvénytelen bejegyzéseket
adott vissza; a rendszer az összes leolvasott adatot
elveti.)

Kérje a helyi országos képviselet segítségét (lásd:
Támogatás 2. oldal).

Jelentés-létrehozási hibák

Több adatbejegyzés tartozik ugyanahhoz a dátumhoz

Ha ugyanazon készülék esetében ugyanahhoz a dátumhoz és időponthoz több adatbejegyzés

tartozik, a rendszer ezt feloldhatatlan ütközésnek érzékeli. Az ezekkel a készülékadatokkal

létrehozott jelentésekben nem fognak szerepelni az egymással átfedésben lévő adatok.

Próbálkozhat a jelentési időszak módosításával oly módon, hogy az ne tartalmazza az átfedésben

lévő adatokat. Vagy azt is megteheti, hogy a korábban mért adatok törlése céljából a készüléket

törli a rendszerből, majd ismét hozzáadja.

A rendszer figyelmen kívül hagy bizonyos adatokat

Ha a készülékidő megváltoztatása legalább háromórás időtartamra vonatkozó adathalmazban

átfedést vagy hiányt okoz, a rendszer az érintett adatokat kihagyja a jelentések készítésekor.
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Biztonsági mentéssel és visszaállítással kapcsolatos hibák

Az adatbázis nem zárolható

Ez akkor fordul elő, ha többfelhasználós környezetben használja a rendszert, és más felhasználók

is be vannak jelentkezve. A rendszer nem engedélyezi az adatbázis biztonsági mentését,

miközben más felhasználók esetleg az adatbázist befolyásoló feladatokat hajtanak végre. Ha az

összes felhasználó kilépett a CareLink Pro alkalmazásból, végrehajthatja az adatbázis biztonsági

mentését.

Nem hajtható végre az adatbázis biztonsági mentése vagy visszaállítása

Más felhasználók nem tudnak bejelentkezni, és nem lehet biztonsági mentést vagy visszaállítást

végrehajtani. Kérje a helyi országos képviselet segítségét (lásd: Támogatás 2. oldal).

Nem sikerül az adatbázis visszaállítása

Az adatbázisról készült azon biztonsági másolat fájlja, amelyet a visszaállítási eljárás során

használni kíván, sérült. A visszaállítást kísérelje meg egy másik biztonságimásolat-fájllal

végrehajtani.

A szoftver eltávolítása

Ha a CareLink Pro eltávolítására van szükség, hajtsa végre az alábbi lépéseket:

1 Nyissa meg a Vezérlőpultot a Windows Start  menüjéből.

2 Válassza a Add or Remove Programs  (Programok telepítése és törlése) lehetőséget. Ekkor

megnyílik a Windows Add or Remove Programs (Programok telepítése és törlése) ablaka.

3 Görgessen lefelé, és jelölje ki a Medtronic CareLink Pro  elemet.

4 Kattintson az Remove  (Eltávolítás) gombra. Ekkor megjelenik a telepítővarázsló.

5 Kattintson a Next  (Tovább) gombra. Ekkor megjelenik egy üzenet, amely az alkalmazás

eltávolításának a megerősítésére kéri.

6 Kattintson a Yes  (Igen) gombra. Az eltávolítóprogram törli az alkalmazást és az ahhoz tartozó

összes fájlt a számítógépről. A művelet befejeződésekor a varázsló egy üzenetben tájékoztat

az eltávolítás végrehajtásáról.

7 Kattintson a Finish  (Befejezés) gombra.
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9

Ikontáblázat

A csomagolás címkéin és a készüléken lévő ikonok és szimbólumok magyarázata a következő

táblázatban látható:

Leírás Ikon

Dobozonként/csomagonként egy (1X)

CD mellékelve

Tekintse át a használati útmutatót.

Gyártás éve

Katalógusszám

Conformité Européenne (Európai megfelelőség). Ez a
jel azt jelenti, hogy az eszköz megfelel az
orvostechnikai eszközökről szóló 93/42/EGK
irányelvnek.
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CSV-adatok

A jelentésadatok a CareLink Pro alkalmazásból való exportálásukkor egy .csv fájlba kerülnek. Ez a

fájl azután számolótábla-alkalmazásokba, például a Microsoft Excel programba importálható. A

CSV-fájlok oszlopainak alábbi leírásából megtudhatja, hogy milyen adatok kerülhetnek be egy

CSV-fájlba.

A CSV-fájl a beteg nevét és betegazonosítóját, a jelentési időszakot, valamint a jelentésbe

szereplő eszközök azonosítását tartalmazza.

Oszlopadatok jelentése

Oszlopfejléc Jelentés

Index (Tárgymutató) Az adatok készülékben történt rögzítésének sorrendje.

Date (Dátum) Az adatok készülékben történt rögzítésének dátuma.

Time (Időpont) Az adatok készülékben történt rögzítésének időpontja.

New Device Time (Új készülékidő) Az új dátum és idő, ha ezek módosultak a
készülékben.

VC mérés eredménye (mmol/l vagy mg/dl)

A mérőeszköz, Guardian készülék vagy pumpa által
mért vércukorszintérték. Ha az adatok pumpából vagy
Guardian készülékből erednek, az oszlopban a kézi és
a Link mérőeszközből származó vércukorszintértékek
láthatók.

Linked BG Meter ID (Csatlakoztatott VC-mérő
azonosítója)

Azon mérőeszköz sorozatszáma, amely egy bizonyos
vércukorszintértéket a készülékre küld.

Basal Rate (U/h) (Bázisütem – E/ó) Az aktív bázisinzulin adagolási üteme óránkénti
egységszámban.

Temp Basal Amount (Ideiglenes bázis mennyisége) Ha ideiglenes bázist adagoltak a pumpával, ez az érték
adja meg az ideiglenes bázis mennyiségét.

Temp Basal Type (Ideiglenes bázis típusa) Az ideiglenes bázis beállításának típusa (inzulinütem
vagy a bázis százaléka).

Temp Basal Duration (m) (Ideiglenes bázis időtartama
– perc)

Az ideiglenes bázisinzulin-adagolás (a típust lásd
feljebb) időtartama percben.
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Oszlopfejléc Jelentés

Bolus Type (Bólus típusa)

A bólusinzulin adagolási típusa [Normal – Normál,
Square – Négyszög, Dual (normal part) – Kéthullámú
(normál rész) vagy Dual (square part) – Kéthullámú
(négyszöghullámú rész)].

Bolus Volume Selected (U) (Választott bólusmennyiség
– E)

A bólusinzulin-adagoláskor történő beadásra kijelölt
inzulinegységek száma.

Bolus Volume Delivered (U) (Beadott bólusmennyiség
– E)

A bólusinzulin-adagoláskor ténylegesen beadott
inzulinegységek száma.

Programmed Bolus Duration (h) (Programozott
bólusidőtartam – ó)

Négyszöghullámú bólus vagy kéthullámú bólus
négyszöghullámú részének időtartama.

Prime Type (Feltöltés típusa)

Kézi vagy rögzített. A kézi feltöltés közvetlenül
visszatekerés után történik az infúziós szerelék
csövének inzulinnal való feltöltéséhez annak bekötése
előtt. A rögzített feltöltés az infúziós szerelék bekötése
után történik a puha kanül inzulinnal való feltöltése
érdekében, a bevezetőtű kivétele után.

Prime Volume Delivered (U) (Beadott feltöltési
mennyiség – E)

A feltöltésként ténylegesen beadott inzulinegységek
száma.

Alarm (Riasztás) A történt riasztás neve.

Suspend (Felfüggesztés) A pumpa felfüggesztett állapotának azonosítása.

Rewind (Visszatekerés) A készülék visszatekerésének dátuma és ideje.

BWZ Estimate (U) (BWZ – becslés (E)) A bólusinzulin becslése, ha a számítás a Paradigm
pumpa Bolus Wizard szolgáltatásával történt.

BWZ Target High BG (mmol/L or mg/dL) (BWZ – VC
felső célértéke – mmol/l vagy mg/dl)

A vércukor céltartományának felső értéke, a Bolus
Wizard szolgáltatás használja.

BWZ Target Low BG (mmol/L or mg/dL) (BWZ – VC
alacsony célértéke - mmol/l vagy mg/dl)

A vércukor céltartományának alsó értéke, a Bolus
Wizard szolgáltatás használja.

BWZ Carb Ratio (BWZ – szénhidrátarány)

Az inzulin-szénhidrát arány értéke. Ha az egység a
gramm, akkor az arány azt jelenti, hogy hány gramm
szénhidrátot kompenzál egy egységnyi inzulin. Ha az
egység a csere, akkor az arány azt jelenti, hogy hány
egységnyi inzulin használatos egy csereegység
szénhidrát kompenzálásához.

BWZ Insulin Sensitivity (BWZ – inzulinérzékenység)

Az inzulinérzékenység beállítása. Az inzulinérzékenység
az az érték, mellyel a vércukorszint egy egységnyi
inzulin hatására csökken. Ezt a Bolus Wizard
szolgáltatás használja.

BWZ Carb Input (BWZ – szénhidrát megadása) A Bolus Wizard szolgáltatásban megadott, illetve a
bólusbecsléshez használt szénhidrátmennyiség.

BWZ BG Input (mmol/L or mg/dL) (BWZ – VC
megadása - mmol/l vagy mg/dl)

A Bolus Wizard szolgáltatásban megadott, illetve a
bólusbecsléshez használt vércukorérték.

BWZ Correction Estimate (U) (BWZ – korrekciós becslés
– E)

A vércukorszint korrigálása érdekében beadandó
bólusinzulin egységszáma a Bolus Wizard számítása
szerint.

BWZ Food Estimate (U) (BWZ – étkezési becslés – E)
A várható szénhidrátfogyasztás kompenzálása
érdekében beadandó bólusinzulin becsült
egységszáma a Bolus Wizard számítása szerint.

BWZ Active Insulin (U) (BWZ – aktív inzulin – E)

A korábbi bólusinzulin-adagolásokból az aktív inzulin
testben maradó mennyiségének számított értéke, ha a
becsült bólusmennyiség meghatározása a Bolus
Wizard szolgáltatással történik.

Sensor Calibration BG (mmol/L or mg/dL)
(Szenzorkalibrálási VC - mmol/l vagy mg/dl)

A szenzor kalibrálásához használt VC-érték mmol/l-ben
vagy mg/dl-ben.
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Oszlopfejléc Jelentés

Sensor Glucose (mmol/L or mg/dL) (Szenzor
glükózértéke - mmol/l vagy mg/dl) A szenzor által mért glükózérték.

ISIG value (ISIG érték) A szenzorról leolvasott, nanoamperben (nA) mért
bemenő jelek (ISIG).

További tudnivalók a CareLink Pro által exportált CSV-fájlokról

A CSV-fájl tetején látható cím a következőket tartalmazza:

• a beteg neve

• a kiválasztott készülékek és sorozatszámaik listája

• a kiválasztott dátumtartomány
 
Az egyes oszlopblokkoknak is van címe, amely a következőket tartalmazza:

• azon eszköz neve, amelyre az adatok vonatkoznak

• ezen eszköz sorozatszáma

Ha az adatok nem a várt módon jelennek meg

Több tényező is szerepet játszhat abban, ha a CSV-adatok a várttól eltérően jelennek meg.

• Az eszköz dátumának és idejének változása hatására módosulhat a sorrend, illetve a kijelölt

dátumtartományon kívüli adatok is megjelenhetnek.

• Ha hosszú idő telik el a készülékleolvasások között, akkor a készülékre vonatkozó adatok több

blokkban jelenhetnek meg.

CareLink Pro Használati útmutató   CSV-adatok 57



Szószedet

A1C - Glikozilált hemoglobin

A1C mérése - A hemoglobin A1C mérése, amellyel egy időszakra vonatkozóan követhető a
vércukorszint.

alacsony glükóz - A pumpa figyelmeztet, ha a szenzor észlelése szerint a felhasználó glükózszintje
erre az értékre vagy ez alá csökken. Ez a funkció engedélyezhető vagy letiltható.

alacsony tartályszint jelzése - Programozható jelzés, amely értesíti, ha már csak adott számú
egység van a pumpa tartályában, illetve ha már csak adott időtartam van hátra a tartály
kiürüléséig.

átlagos abszolút eltérés % (MAD%) - A szenzor vércukormérő-eszközhöz történő kalibrálásának
pontossági szintjét adja meg. Minél kisebb ez a szám, annál pontosabb a kalibrálás. Az MAD%
kiszámításához az egymáshoz közeli szenzor-glükózértékek és a VC-mérővel mért értékek
páronkénti különbségét veszik, ezt elosztják a VC-mérővel végzett mérés eredményével, majd
átlagot számítanak az összes párra vonatkozóan.

bázisinzulin - Óránkénti, folyamatosan adagolt inzulin, amelyet az inzulinpumpa automatikusan
ad be a pumpán beállított előre programozott profilok és személyre szabott ütemek alapján. A
pumpa adagol egy napi inzulinmennyiséget, amely általában fedezi a háttérinzulinszintet az
étkezésmentes időszakokra (például éjszakára és az étkezések között).

bázisprofil - Kezdő- és záróidőponttal rendelkező bázisütem. A felhasználó egy 24 órás időszakra
több különböző profilt programozhat be a pumpán, eltérő bázisütemekkel, a jobb
vércukorszint-szabályozás érdekében.

bázissémák - A felhasználó legfeljebb három különböző bázisütem-sémát programozhat be a
pumpán a bázisinzulin beadásához: Standard (Normál), A és B. Az egyes sémákhoz legfeljebb 48
bázisütem állítható be.

bázisütem - A pumpa azon beállítása, mely folyamatos inzulininfúziót tart fenn, ezáltal stabilan
tartja a vércukrot az étkezések között és éjszaka. A bázisinzulin a hasnyálmirigy
inzulintermelését utánozza – ez fedezi a szervezet nem táplálékhoz kötött inzulinszükségletét.

bólusinzulin - Egy adag inzulin, mely a várható (például étkezés utáni) vércukor-emelkedést
kompenzálja, vagy a céltartományba csökkenti a magas vércukorértéket.

CareLink® Personal - Online szolgáltatás, amely lehetővé teszi a diabéteszadatok kezelését az
interneten.

CH - Szénhidrát

CH-arány (szénhidrátarány) - Az a szénhidrátmennyiség, amelyet egy egységnyi inzulin
kompenzál. (Lásd még: cserearány.)

CH-egység - A táplálékbevitel a Bolus Wizard használatakor. Megadható (szénhidrát)grammban
vagy csereegységben.
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ComLink - Rádiófrekvenciás adó-vevő készülék, amellyel a Paradigm pumpa adatai letölthetők a
számítógépre.

Com-Station - Olyan eszköz, amellyel a MiniMed 508 pumpa és a külső cégek által gyártott
mérőeszközök átmenő adatai letölthetők a számítógépre.

csatlakozás
(1) A mérőopció bekapcsolása és beállítása ahhoz, hogy a pumpa fogadja a pumpával
kommunikáló mérőeszköz által mért vércukoreredményeket.
(2)

cserearány - Az az inzulinmennyiség, amely egy (1) csereegység szénhidrát kompenzálásához
szükséges. (Lásd még: CH-arány.)

Dual Wave® bólus - (Kéthullámú bólus) Az azonnal adagolt normál bolus és az azt követő Square
Wave (négyszöghullámú) bólus kombinációja. A négyszöghullámú rész adagolása adott
időtartamon belül egyenletes.

Easy Bolus™ - (Egyszerű bólus) A normál bólus beadásának módja az Easy Bolus gomb
megnyomásával a pumpán.

expressz bólus - Bármely típusú bólus beadásának módja a pumpa Express bólus gombjának
megnyomásával.

étkezési bólus - Az az inzulinadag, amely kompenzálja az étkezések után várhatóan bekövetkező
vércukor-emelkedést.

felfüggesztés - A pumpa azon funkciója, amely minden inzulinadagolást leállít. Minden aktuális
bólusbeadás és/vagy feltöltés megszakad. A bázis adagolása újraindításig szünetel.

feltöltés - A pumpa vagy mérőeszköz adatainak átvitele a CareLink® Personal kiszolgálóra.

görbe alatti terület (AUC) - A felfelé és lefelé történő kilengések mennyiségét jelzi az előre
beállított értékek alapján. A kilengésadatok a felső és alsó értékek gyakoriságát jelzik. A görbe
alatti terület az események mértékét jelzi úgy, hogy megmutatja, milyen mértékben és mennyi
ideig kerülnek ki az értékek a tartományból.

hangjelzéses bólus - A pumpa beprogramozható úgy, hogy a felhasználó egy sípolást halljon egy
beadandó bólusinzulin-mennyiség (0,5 vagy 1,0 egység) kiválasztásakor. Ez olyan helyzetekben
hasznos, amikor a pumpa gombjai nem láthatók jól.

HbA1c - Glikozilált hemoglobin

HbA1c mérése - A hemoglobin A1C mérése, amellyel a vércukor-szabályozás vagy a szintek átlaga
mérhető egy 2-3 hónapos időszakra vonatkozóan.

hiperglikémia - Megemelkedett vércukorszint, amely vércukorszintméréssel mutatható ki, és a
következő tünetek kísérhetik: hányinger, hányás, homályos látás, fejfájás, gyomorbántalmak,
gyakori és nagy mennyiségű vizeletürítés, valamint levertség.

hipoglikémia - Alacsony vércukorszint, amely vércukorszintméréssel mutatható ki, és a következő
tünetek kísérhetik: túlzott éhség, remegés vagy reszketés, izzadás, „táncoló” látás, szédülés,
fejfájás, zavaros beszéd, hirtelen hangulatváltások, valamint személyiségváltozás.

ideiglenes - Ideiglenes.

ideiglenes bázis - Ideiglenes, egyszeri bázisinzulin megadott adagban és időtartamig. A speciális,
nem mindennapos tevékenységekkel vagy állapotokkal járó inzulinszükségletet elégíti ki.

infúziós szerelék - Olyan eszköz, amellyel a kanül beilleszthető és rögzíthető a bőr alatt, valamint
az inzulin csöveken át a pumpából a bevezetési helyre továbbítható.

Inzulinérzékenység - Az az érték mmol/l-ben (vagy mg/dl-ben), mellyel a vércukorszint (VC) egy
egységnyi inzulin hatására csökken. (A Bolus Wizard adata.)

inzulinkoncentráció - Az orvos által a felhasználó számára előírt erősségű vagy típusú inzulin. Ez
hatással van a pumpa által beadott inzulin ütemére. Ha a felhasználó inzulinkoncentrációja
változik, a bázissémákat, valamint a maximális bázis- és bólusütemeket újra kell programozni a
pumpán.
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ISIG - Szenzorértékek, amelyek azt jelzik, hogy egy szenzorral felszerelt rendszerben a távadó
elektronikája megfelelően működik-e. Amennyiben az ISIG értéke kisebb, mint 24,00 nA vagy
nagyobb, mint 29,00 nA, kérjen terméktámogatást. Lehet, hogy ki kell cserélni a távadót.

kalibrálásra való figyelmeztetés - A pumpa 12 óránként automatikusan elindítja a "VC mérése
legkésőbb ekkor: óó:pp" értesítést, ami azt jelzi, hogy a jelenlegi kalibrációs érték érvényét
vesztette. A kalibrálási figyelmeztetés értékeként az az idő jelenik meg, amely az aktuális
kalibrálási érték lejártáig hátra van (a felhasználó beállítása alapján). Ha például a kalibrálási
emlékeztető értéke 2 órára van állítva, a "VC mérése legkésőbb ekkor: óó:pp" értesítés 2 órával a
szükséges kalibrálás előtt aktiválódik.

ketonellenőrzés - A keton olyan melléktermék, amely akkor jön létre, ha a szervezet arra
kényszerül, hogy cukor helyett zsírt égessen az energianyeréshez. Ez jelezhet inzulinhiányt a
szervezetben. A ketonellenőrzés a vérben vagy a vizeletben méri a ketonkoncentrációt.

kézi bólus - (Manual Bolus) A Bólus menü egyik választható eleme, ha a Bolus Wizard szolgáltatás
aktív. A bólusprogramozás egyik, a Bolus Wizard használata nélküli módja.

korrekciós bólus - Az az inzulinmennyiség, amely a magas vércukorszint céltartományba való
csökkentéséhez szükséges.

korrekciós tényező - Az a mennyiség, amellyel a vércukor 1,0 egység inzulin hatására csökken. Ez
a tényező használható a korrekciós bólus mennyiségének kiszámítására, ha magas a
vércukorszint. (VC-szint) - (VC-célérték) = X. X ÷ (korrekciós tényező) = korrekciós bólus
mennyisége

lépés - Az inzulin mértékegysége, melyet az Easy Bolus szolgáltatással történő beadáshoz lehet
beállítani és használni.

magas glükóz - A pumpa figyelmeztet, ha a szenzor észlelése szerint a felhasználó glükózszintje
eléri vagy túllépi ezt az értéket. Ez a funkció engedélyezhető vagy letiltható.

maximális bázisinzulin - Az a maximális mennyiségű bázisinzulin, amelyet a pumpa egyszerre ad
le. (A felhasználó állítja be.)

maximális bólus - Az a maximális mennyiségű bólusinzulin, amelyet a pumpa egyszerre ad le. (A
felhasználó állítja be.)

Mérőkészülék - Olyan orvosi készülék, amellyel megközelítőleg meghatározható a vércukor
koncentrációja. A vizsgálathoz vércseppet helyeznek egy egyszer használatos tesztcsíkra,
amelyet a mérőeszköz leolvas, majd ez alapján kiszámítja a vércukorszintet. A mérőeszköz
mmol/l-ben vagy mg/dl-ben adja meg a szintet.

mérőopció - Olyan szolgáltatás, amellyel engedélyezhető, hogy a pumpa fogadja egy
csatlakoztatott vércukormérő eszköz által mért vércukorértékeket.

négyszöghullámú rész - (Sq) A kéthullámú bólus második része. A négyszöghullámú rész
adagolása az azonnali adagrész beadása után, egyenletesen, adott ideig történik.

normál bólus - Adott egységnyi inzulin azonnali beadása.

normál séma - A normál bázis a szokásos napi tevékenységekhez. Ha a sémaszolgáltatás ki van
kapcsolva, a pumpa a normál sémát használja.

RF - Rádiófrekvenciás

sémaszolgáltatás - A pumpa funkcióit bővítő szolgáltatás, mellyel opcionális bázisok (A séma, B
séma) programozhatók be. Ezek azon tevékenységeket vagy vércukorsémákat támogatják,
melyek a napi rutinnak nem részei, de rendszeresek. Ilyen például a heti egyszeri sportolás, az
alvási szokások változása a hétvégén vagy a menstruációs ciklus alatti hormonális változások.

Square Wave® bólus - (Szögletes hullámú bólus) Egyenletesen, adott ideig (30 perc–8 óra) adagolt
bólus.

távadó azonosítója - Az éppen használatban lévő távadó sorozatszáma.

VC - A vércukor rövidítése
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